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IN THE UNITED STATES PATENT AND TRADEMARK OFFICE

UTILITY APPLICATION AND FEE TRANSMITTAL §gl.53g Ell

Mail Stop
Commissioner for Patents

PO. Box 1450

Alexandria, VA 22313-1450

Sir:

Transmitted herewith for filing is the patent application of

Inventor(s) names and addresses:

(1) Keith R. McNally

5104 Seagrove Cove

San Diego, CA 92130

(2) William H. Roof
13429 Luckett Court

San Diego, CA 92130

(3) Richard Bergfeld
20719 Nashville Street .

Chatsworth, CA 913 1 1 /I

[1 Additional inventors are listed on a separate sheet

For: INFORMATION MANAGEMENT AND SYNCHRONOUS COMMUNICATIONS SYSTEM WITH

MENU GENERATION, AND HANDWRITING AND VOICE MODIFICATION OF ORDERS

Enclosed Are:

SQ page(s) of specification

1 page(s) of Abstract

§ page(s) of claims

§ sheets of IX Formal E] Informal drawings

é page(s) ofDeclaration and Power of Attorney

CI Unsigned

CI Newly Executed

IE Copy from prior application

[:1 Deletion of inventors including Signed Statement under 37 CPR. §1.63(d)(2)

REQUEST AND CERTIFICATION UNDER 35 U.S.C. §122(b)(2)(B)(i) (form PTO/SB/35)El

As indicated on the attached Request and Certification, Applicant(s) certify that the invention disclosed in

the attached application HAS NOT and WILL NOT be the subject of an application filed in another
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country, or under a multilateral agreement, that requires publication at eighteen months afier filing.

Applicant(s) therefore request(s) that the attached application NOT be published under 35 U.S.C. §122(b).

Incorporation by Reference:

E The entire disclosure of the prior application, from which a copy of the combined Declaration and

Power of Attorney is supplied herein, is considered as being part of the disclosure of the

accompanying application and is incorporated herein by reference.

Deletion of Inventors (37 C.F.R. §1.63(d) and §l.33(b)

 

 

Signed statement attached deleting inventor(s) named in the prior application serial no. , filed .

C] Microfiche Computer Program (Appendix)

E] page(s) of Sequence Listing

E] computer readable disk containing Sequence Listing

[:1 Statement under 37 C.F.R. §1.821(t) that computer and paper copies of the Sequence Listing are the
same

E Assignment Papers (assignment cover sheet and assignment documents)

El A check in the amount of $40.00 for recording the Assignment

El Charge the Assignment Recordation Fee to Deposit Account No. 13-4500, Order No. .

IX Assignment Papers filed in the parent application Serial No. 09/400 413

E] Certification of chain of title pursuant to 37 C.F.R. §3.73(b)

I: Priority is claimed under 35 U.S.C. §119 for:

Application No(s). ’, filed , in (country).

[I Certified Copy of Priority Document(s) [ ]

[:1 filed herewith

[:1 filed in application Serial No. , filed .

I] English translation document(s) [ ]

I: filed herewith

I] filed in application Serial No. , filed .

[I Priority is claimed under 35 U.S.C. §119(e) for:
Provisional Application No. , filed .

D Information Disclosure Statement

E] Copy of [ | cited references

E] PTO Form-1449

E] References cited in parent application Serial No. , filed .

C] Related Case Statement under 37 C.F.R. §1.98(a)(2)(iii)

I] A copy of related pending U.S. Application(s) Serial No(s): , filed , respectively, is
attached hereto.

E] A copy of related pending U.S. Application(s) entitled, , filed to inventor(s) ,
respectively, is attached hereto.

E] A copy of each related application(s) was submitted in parent application serial no. , filed

E Preliminary Amendment

E Return receipt postcard (MPEP 503)

_2_
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E This is a E continuation El divisional E] continuation-in-part of prior application serial no. 10/016 517,
filed November 1 2001 which is a continuation-in—part of application serial no. 09/400,413, filed

September 21, 1999, to which priority under 35 U.S.C. §120 is claimed.

 

 

D Cancel in this application original claims of the parent application before calculating the filing

fee. (At least one original independent claim must be retained for filing purposes.)

E A Preliminary Amendment is enclosed. (Claims added by this Amendment have been properly
numbered consecutively beginning with the number following the highest numbered original claim in

the prior application).

[:1 The status of the parent application is as follows:

[:1 A Petition for Extension of Time and a Fee therefor has been or is being filed in the parent application

to extend the term for action in the parent application until

[I A copy of the Petition for Extension of Time in the co-pending parent application is attached.

I] No Petition for Extension ofTime and Fee therefor are necessary in the co-pending parent

application.

C] Please abandon the parent application at a time while the parent application is pending or at a time when
the petition for extension of time in that application is granted and while this application is pending has

been granted a filing date, so as to make this application co-pending.

Transfer the drawing(s) from the parent application to this application

XIII] Amend the specification by inserting before the first line the sentence:
This is E continuation [:1 divisional E] continuation-in-part of co-pending application Serial No.
10/016 517, filed November 1 2001, which is a continuation-in-part of application serial no. 09/400 413,

filed September 21, 1999.

   

 

  

  

  
  
  

  

  
 

I. CALCULATION OF APPLICATION FEE

Basic Fee ($300/$150) $ 150.00

Examination Fee ($200/$100) $ 100.00

Search Fee ($500/$250) $ 250.00

J. NumberFiled .0
Total Claims 102.20 = ($50/$25) $ 2,050.00

Independent Claims 12 - 3 = ($200/$100) $ 900.00

IX] Multiple Dependent Claims If marked, add fee of $360/$l80 $ 180.00

Total Sheets Extra Sheets Number of each additional 50 or fraction thereof Fee TNT—”TW— i

38- 100 = 0/50 = (round up to the whole number) ($250/$125)

0 0000-00
  

X Small entity status is or has been claimed. Reduced fees under 37 CPR. §l.9 (i) paid herewith
 

 

$3 630.00.

E A check in the amount of $3 630.00 in payment of the application filing fees is attached. .

I] . Charge fee to Deposit Account No. 13-4500, Order No. . A DUPLICATE COPY OF THIS SHEET
IS ATTACHED.

-3-
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IX] The Commissioner is hereby authorized to charge any additional fees which may be required for filing this

application pursuant to 37 CFR §1.16, including all extension of time fees pursuant to 37 C.F.R. § 1.17
for maintaining copendency with the parent application, or credit any overpayment to Deposit Account
No. 13-4500 Order No. 3125—4003USI. A DUPLICATE COPY OF THIS SHEET IS ATTACHED. 

Respectfully submitted,
MORGAN & FINNEGAN, L.L.P.

Dated: April 22, 2005 By: %
Angus R.Gill

Registration No. 51,133

Correspondence Address:

MORGAN & FINNEGAN, L.L.P.
3 World Financial Center

New York, NY 10281-2101

(212) 415-8700 Telephone

(212) 415-8701 Facsimile
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E E Serial NolGontinuation of 10/016,517{\2

§ v; IN THE UNITED STATES PATENT AND TRADEMARK OFFICE
E 3:0

E 3 Applicant(s): McNally et al.
0 Group Art Unit: 2173 (parent case)

Serial No.: Continuation of 10/016,517

Examiner: Cao Nguyen (parent case)

Filed: HEREWITH

For: INFORMATION MANAGEMENT AND SYNCHRONOUS

COMIVIUNICATIONS SYSTEM WITH MENU GENERATION, AND

HANDWRITING AND VOICE MODIFICATION OF ORDERS

EXPRESS MAIL CERTIFICATE

Commissioner for Patents

PO. Box 1450

Alexandria, VA 22313-1450

Express Mail Label No.: EV .460 047 160 US

Date of Deposit: April 22, 2005

I hereby certify that the following attached paper(s) and/or fee

Utility Application and Fee Transmittal - 4 pages (in duplicate)

Specification with Claims & Abstract- 37 pages

1

2

3. 8 Sheets of Formal Drawings (FIGS. 1 9-)

4. Copy of executed Combined Declaration/Power of Attorney from Serial No. 09/400,413- 6 pages
5

6
Preliminary Amendment- 29 pages (in duplicate)

Check for $3,630. 00 (filing fees)

7. Postcard for Receipt Acknowledgement

is being deposited with the United States Postal Service “Express Mail Post Office to Addressee”

service under 37 C.FR. §1. 10 on the date indicated above andIS addressed to Commissioner for

Patents, PO. Box 1450, Alexandria, VA 22313—1450.

M ,

rinted name of persoéfiéilgng papers(s) and/or fee)
ofperson mailing paper(s) and/or fee)  

 Correspondence Address:

MORGAN & FINNEGAN, L.L.P.

3 World Financial Center

New York, NY 10281—2101

(212) 415-8700 Telephone

(212) 415-8701 Facsimile
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IN THE UNITED STATES PATENT AND TRADEMARK OFFICE

UTILITY APPLICATION AND FEE TRANSMITTAL §gl.53g Ell

Mail Stop
Commissioner for Patents

PO. Box 1450

Alexandria, VA 22313-1450

Sir:

Transmitted herewith for filing is the patent application of

Inventor(s) names and addresses:

(1) Keith R. McNally

5104 Seagrove Cove

San Diego, CA 92130

(2) William H. Roof
13429 Luckett Court

San Diego, CA 92130

(3) Richard Bergfeld
20719 Nashville Street .

Chatsworth, CA 913 1 1 /I

[1 Additional inventors are listed on a separate sheet

For: INFORMATION MANAGEMENT AND SYNCHRONOUS COMMUNICATIONS SYSTEM WITH

MENU GENERATION, AND HANDWRITING AND VOICE MODIFICATION OF ORDERS

Enclosed Are:

SQ page(s) of specification

1 page(s) of Abstract

§ page(s) of claims

§ sheets of IX Formal E] Informal drawings

é page(s) ofDeclaration and Power of Attorney

CI Unsigned

CI Newly Executed

IE Copy from prior application

[:1 Deletion of inventors including Signed Statement under 37 CPR. §1.63(d)(2)

REQUEST AND CERTIFICATION UNDER 35 U.S.C. §122(b)(2)(B)(i) (form PTO/SB/35)El

As indicated on the attached Request and Certification, Applicant(s) certify that the invention disclosed in

the attached application HAS NOT and WILL NOT be the subject of an application filed in another
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country, or under a multilateral agreement, that requires publication at eighteen months afier filing.

Applicant(s) therefore request(s) that the attached application NOT be published under 35 U.S.C. §122(b).

Incorporation by Reference:

E The entire disclosure of the prior application, from which a copy of the combined Declaration and

Power of Attorney is supplied herein, is considered as being part of the disclosure of the

accompanying application and is incorporated herein by reference.

Deletion of Inventors (37 C.F.R. §1.63(d) and §l.33(b)

 

 

Signed statement attached deleting inventor(s) named in the prior application serial no. , filed .

C] Microfiche Computer Program (Appendix)

E] page(s) of Sequence Listing

E] computer readable disk containing Sequence Listing

[:1 Statement under 37 C.F.R. §1.821(t) that computer and paper copies of the Sequence Listing are the
same

E Assignment Papers (assignment cover sheet and assignment documents)

El A check in the amount of $40.00 for recording the Assignment

El Charge the Assignment Recordation Fee to Deposit Account No. 13-4500, Order No. .

IX Assignment Papers filed in the parent application Serial No. 09/400 413

E] Certification of chain of title pursuant to 37 C.F.R. §3.73(b)

I: Priority is claimed under 35 U.S.C. §119 for:

Application No(s). ’, filed , in (country).

[I Certified Copy of Priority Document(s) [ ]

[:1 filed herewith

[:1 filed in application Serial No. , filed .

I] English translation document(s) [ ]

I: filed herewith

I] filed in application Serial No. , filed .

[I Priority is claimed under 35 U.S.C. §119(e) for:
Provisional Application No. , filed .

D Information Disclosure Statement

E] Copy of [ | cited references

E] PTO Form-1449

E] References cited in parent application Serial No. , filed .

C] Related Case Statement under 37 C.F.R. §1.98(a)(2)(iii)

I] A copy of related pending U.S. Application(s) Serial No(s): , filed , respectively, is
attached hereto.

E] A copy of related pending U.S. Application(s) entitled, , filed to inventor(s) ,
respectively, is attached hereto.

E] A copy of each related application(s) was submitted in parent application serial no. , filed

E Preliminary Amendment

E Return receipt postcard (MPEP 503)

_2_
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E This is a E continuation El divisional E] continuation-in-part of prior application serial no. 10/016 517,
filed November 1 2001 which is a continuation-in—part of application serial no. 09/400,413, filed

September 21, 1999, to which priority under 35 U.S.C. §120 is claimed.

 

 

D Cancel in this application original claims of the parent application before calculating the filing

fee. (At least one original independent claim must be retained for filing purposes.)

E A Preliminary Amendment is enclosed. (Claims added by this Amendment have been properly
numbered consecutively beginning with the number following the highest numbered original claim in

the prior application).

[:1 The status of the parent application is as follows:

[:1 A Petition for Extension of Time and a Fee therefor has been or is being filed in the parent application

to extend the term for action in the parent application until

[I A copy of the Petition for Extension of Time in the co-pending parent application is attached.

I] No Petition for Extension ofTime and Fee therefor are necessary in the co-pending parent

application.

C] Please abandon the parent application at a time while the parent application is pending or at a time when
the petition for extension of time in that application is granted and while this application is pending has

been granted a filing date, so as to make this application co-pending.

Transfer the drawing(s) from the parent application to this application

XIII] Amend the specification by inserting before the first line the sentence:
This is E continuation [:1 divisional E] continuation-in-part of co-pending application Serial No.
10/016 517, filed November 1 2001, which is a continuation-in-part of application serial no. 09/400 413,

filed September 21, 1999.

   

 

  

  

  
  
  

  

  
 

I. CALCULATION OF APPLICATION FEE

Basic Fee ($300/$150) $ 150.00

Examination Fee ($200/$100) $ 100.00

Search Fee ($500/$250) $ 250.00

J. NumberFiled .0
Total Claims 102.20 = ($50/$25) $ 2,050.00

Independent Claims 12 - 3 = ($200/$100) $ 900.00

IX] Multiple Dependent Claims If marked, add fee of $360/$l80 $ 180.00

Total Sheets Extra Sheets Number of each additional 50 or fraction thereof Fee TNT—”TW— i

38- 100 = 0/50 = (round up to the whole number) ($250/$125)

0 0000-00
  

X Small entity status is or has been claimed. Reduced fees under 37 CPR. §l.9 (i) paid herewith
 

 

$3 630.00.

E A check in the amount of $3 630.00 in payment of the application filing fees is attached. .

I] . Charge fee to Deposit Account No. 13-4500, Order No. . A DUPLICATE COPY OF THIS SHEET
IS ATTACHED.

-3-
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IX] The Commissioner is hereby authorized to charge any additional fees which may be required for filing this

application pursuant to 37 CFR §1.16, including all extension of time fees pursuant to 37 C.F.R. § 1.17
for maintaining copendency with the parent application, or credit any overpayment to Deposit Account
No. 13-4500 Order No. 3125—4003USI. A DUPLICATE COPY OF THIS SHEET IS ATTACHED. 

Respectfully submitted,
MORGAN & FINNEGAN, L.L.P.

Dated: April 22, 2005 By: %
Angus R.Gill

Registration No. 51,133

Correspondence Address:

MORGAN & FINNEGAN, L.L.P.
3 World Financial Center

New York, NY 10281-2101

(212) 415-8700 Telephone

(212) 415-8701 Facsimile
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E E Serial NolGontinuation of 10/016,517{\2

§ v; IN THE UNITED STATES PATENT AND TRADEMARK OFFICE
E 3:0

E 3 Applicant(s): McNally et al.
0 Group Art Unit: 2173 (parent case)

Serial No.: Continuation of 10/016,517

Examiner: Cao Nguyen (parent case)

Filed: HEREWITH

For: INFORMATION MANAGEMENT AND SYNCHRONOUS

COMIVIUNICATIONS SYSTEM WITH MENU GENERATION, AND

HANDWRITING AND VOICE MODIFICATION OF ORDERS

EXPRESS MAIL CERTIFICATE

Commissioner for Patents

PO. Box 1450

Alexandria, VA 22313-1450

Express Mail Label No.: EV .460 047 160 US

Date of Deposit: April 22, 2005

I hereby certify that the following attached paper(s) and/or fee

Utility Application and Fee Transmittal - 4 pages (in duplicate)

Specification with Claims & Abstract- 37 pages

1

2

3. 8 Sheets of Formal Drawings (FIGS. 1 9-)

4. Copy of executed Combined Declaration/Power of Attorney from Serial No. 09/400,413- 6 pages
5

6
Preliminary Amendment- 29 pages (in duplicate)

Check for $3,630. 00 (filing fees)

7. Postcard for Receipt Acknowledgement

is being deposited with the United States Postal Service “Express Mail Post Office to Addressee”

service under 37 C.FR. §1. 10 on the date indicated above andIS addressed to Commissioner for

Patents, PO. Box 1450, Alexandria, VA 22313—1450.

M ,

rinted name of persoéfiéilgng papers(s) and/or fee)
ofperson mailing paper(s) and/or fee)  

 Correspondence Address:

MORGAN & FINNEGAN, L.L.P.

3 World Financial Center

New York, NY 10281—2101

(212) 415-8700 Telephone

(212) 415-8701 Facsimile
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UNITED STATES PATENT APPLICATION

For:

INFORMATION MANAGEMENT AND SYNCHRONOUS COMMUNICATIONS

SYSTEM WITH MENU GENERATION, AND HANDWRITING AND VOICE
MODIFICATION OF ORDERS

Inventors:

KEITH R. MCNALLY

WILLIAM H. ROOF

RICHARD BERGFELD
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1 UNITED STATES PATENT APPLICATION

2

3 OF: KEITH R. MCNALLY

4 WILLIAM H. ROOF

5 RICHARD BERGFELD

6

7

8 FOR: INFORMATION MANAGEMENT AND SYNCHRONOUS

9 COMMUNICATIONS SYSTEM WITH MENU

10 GENERATION, AND HANDWRITING AND VOICE
11 MODIFICATION OF ORDERS

12

13 The present application is a continuation of Application Serial No. 10/016,517,

14 filed November 1, 2001, which is a continuation-in-part of Application Serial No. 09/400,413,

15 filed September 21, 1999 (now US. Patent No. 6,384,850). The contents of Application Serial

16 No. 10/016,517 and Application Serial No. 09/400,413 are incorporated herein by reference.

17 FIELD OF THE INVENTION

18 This invention relates to an information management and synchronous

19 communications system and method for generation of computerized menus for restaurants and

20 other applications with specialized display and synchronous communications requirements

21 related to, for example, the use of equipment or software with non-PC—standard graphical

22 formats, display sizes and/or applications for use in remote data entry, information management

23 ' and synchronous communication between host Computer, digital input device or remote pager

24 via standard hardwired connection, the intemet, a wireless link, smart phone or the like.

25 BACKGROUND OF THE INVENTION

26 While computers have dramatically altered many aspects of modern life, pen and

27 paper have prevailed in the hospitality industry, e.g., for restaurant ordering, reservations and

-2-
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wait-list management, because of their simplicity, ease of training and operational speed. For

example, ordering prepared foods has historically been done verbally, either directly to a waiter

or over the telephone, whereupon the placed order is recorded on paper by the recipient or

instantly filled.

Although not previously adapted for wide-scale use in the hospitality industry,

various forms of digital wireless communication devices are in common use, e.g., digital

wireless messengers and pagers. Also in common use are portable laptop and handheld devices.

However, user—friendly information management and communication capability not requiring

extensive computer expertise has not heretofore been available for use in everyday life such as

for restaurant ordering, reservations and wait-list management. Hundreds of millions of dollars

have been spent on personal digital assistant (“PDA”) development seeking to produce a small,

light-weight and inexpensive device that could be adapted to such uses; yet none have yielded a ‘

satisfactory solution.

One of the inherent shortcomings of FDA type devices is that, as they strive for

small size, low weight and low cost, they must compromise the size and clarity of the operator

display medium interface itself, which in most cases is one of a variety of LCD (liquid crystal

display) type devices. As the size of the display shrinks, the amount of information that may be

displayed at any one point or time is commensurately decreased, typically requiring multiple

screens and displays to display information to the operator. This reduces the overall utility of the

device. Additionally, the smaller display and keyboard results in a non-optimal operator

interface, which slows down operation and is thus unacceptable for the time criticality of

ordering, reservation and wait-list management and other similar applications. This necessitates

914001 vl
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many design compromises which in the aggregate have resulted in limited acceptance of FDA

type devices in the restaurant and hospitality fields.

Many of the negatives prevalent in earlier devices have been eliminated, but, to

date, there is still no integrated solution to the ordering/waitlist/reservation problem discussed

above. With the advent of the Palm® and other handheld wireless devices, however, the efforts

to make such devices ubiquitous have begun to bear fruit at least in some areas, e.g., personal

calendars. However, substantial use of such devices in the restaurant 'and hospitality context has

not occurred to date. As discussed above, at least one of the reasons PDAs have not been

quickly assimilated into the restaurant and hospitality industries is that their small display sizes

are not readily amenable to display of menus as they are commonly printed on paper or displayed

on, e.g., large, color desktop computer screens. Another reason is that software for fully

realizing the potential for wireless handheld computing devices has not previously been

available. Such features would include fast and automatic synchronization between a central

database and multiple handheld devices, synchronization and communication between a World

Wide Web (“Web”) server and multiple handheld devices, a well-defined application program

interface (“API”) that enables third parties such as point of sale (“POS”) companies, affinity

program companies and internet content providers to fully integrate with computerized

hospitality applications, real-time communication over the internet with direct connections or

regular modern dialup connections and support for batch processing that can be done periodically

throughout the day to keep multiple sites in synch with the central database. A single point of

entry for all hospitality applications to communicate with one another wirelessly has also

previously been unavailable. Such a single point of entry would work to keep all wireless

handheld devices and linked Web sites in synch with the backoffice server (central database) so

- 4 -
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that the different components are in equilibrium at any given time and an overall consistency is

achieved. For example, a reservation made online would be automatically communicated to the

backoflice server and then synchronized with all the wireless handheld devices wirelessly.

Similarly, changes made on any of the wireless handheld devices would be reflected

instantaneously on the backoffice server, Web pages and the other handheld devices.

For the foregoing reasons, paper-based ordering, waitlist and reservations

management have persisted in the face of widespread computerization in practically all areas of

commerce. At most, computerization of these functions has been largely limited to fixed

computer solutions, i.e., desktop or mainframe, because of the problems heretofore faced in

configuring wireless handheld devices and maintaining database synchronization for such

applications. Specifically, the unavailability of any simple technique for creating restaurant

menus and the like for use in a limited display area wireless handheld device or that is

compatible with ordering over the intemet has prevented widespread adoption of

computerization in the hospitality industry. Without a viable solution for this problem,

organizations have not made the efforts or investments to establish automated interfaces to

handheld and Web site menus and ordering options.

A principal object of the present invention is to provide an improved information

management and synchronous communications system and method which facilitates user-

friendly and efficient generation of computerized menus for restaurants and other applications

that utilize equipment with non-PC-standard graphical formats, display sizes and/or applications.

A further object of the present invention is to provide an improved information

management and synchronous communications system. and method which provides for entry,

management and communication of information from the operator as well as to and from another

-5-
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computer, Web page menu, remote digital device using a standard hardwired connection, the

intemet or a wireless link.

A further object of the present invention is to provide an improved information

management and synchronous communications system which is small, affordable and

lightweight yet incorporates a user—friendly operator interface and displays menus in a readily

comprehensible format.

A filrther object of the present invention is to provide a synchronous information

management and communications system which enables automatic updating of both wireless and

intemet menu systems when a new menu item is added, modified or deleted from any element of

the system.

SUMMARY OF THE INVENTION

The foregoing and other objects of the present invention are provided by a

synchronous information management and communications system and method optimized for

simplicity of operation which incorporates menu generation for creation of menus to be used

with wireless remote handheld computer and PDA devices, the internet or any application where

simple and efficient generation of menus is appropriate. The menu generation approach of the

present invention includes a desktop software application that enables the rapid creation and

building of a menu and provides a means to instantly download the menu configuration onto,

e.g., a handheld device or Web page and to seamlessly interface with standard point of sale

(“POS”) systems to enable automatic database updates and communication exchanges when a

change or input occurs in any of the other system elements. To solve the above and other related

problems, an information management and communications system is provided which results in

a dramatic reduction in the amount of time, and hence cost, to generate and maintain
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computerized menus for, e.g., restaurants and other related applications that utilize non-PC-

standard graphical formats, display sizes or applications.

The menu generation approach of the present invention has many advantages over

previous approaches in solving the problem of converting paper-based menus or Windows® PC-

based menu screens to small PDA-sized displays and Web pages. In one embodiment, the

present invention is a software tool for building a menu, optimizing the process of how the menu

can be downloaded to either a handheld device or Web page, and making manual or automatic

modifications to the menu after initial creation.

Manual modifications to the generated menus include handwritten screen captures

and/or voice recorded message captures coupled with the standard menus and modifiers

generated according to standard choices . Such manual modifications enable an extremely rapid

and intuitive interface to enhance operations and further optimize the overall operator interface.

This approach solves a long-standing, operational issue in restaurant/hotel/casino food/drink

ordering when customers want something unusual and not anticipated and available through

normal computerized selections. As seen in Figure 8, the operator screen on the hand-held can

capture handwritten information specific to a customers requests directly on the touch-sensitive

screen of the wireless computing device. This additional information can then be coupled with

the fixed menu and modifier information generated automatically from the. hospitality

application software and the combined message can be sent to a restaurant point of sale (POS)

system, printer or/or display system. This unique operator interface enables universal languages

and an unlimited set of information to be manually communicated and exchanged. The resultant

combined message of one or more fixed indications selected from a menu of a device such as a
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hand-held, and dynamic handwritten messages and/or data provides an even more powerful tool

than either modality used independently.

For example a restaurant server taking a drink order could select from a menu of

her hand-held device’s screen “Iced Tea”, and then manually write in the literal screen of her

hand-held “with lemon” as shown in Figure 8. The manually-written information could, for

example, be printed or displayed in front of a bartender preparing the drink order. The indication

“Iced Tea” as selected from a menu of the hand-held would also be presented to the bartender,

perhaps by printing and/or screen display. The server can also select any printer from within the

hospitality establishment directly from the operator interface on the screen of the hand-held and

have either the order or the receipt printed out where it is most convenient and efficient.

Similarly, a server taking a drink order could select from a menu of her hand—held

device’s screen “Iced Tea”, and then record the voice message “with lemon” using her hand-held

device integral microphone. The recorded information could, for example, be played on a

speaker attached to a computer, POS system, or the like located near the bartender or chef

preparing the order. The indication “Iced Tea” as selected from a menu of the hand-held would

also be presented to the bartender/chef, perhaps by printing and/or screen display. Both the literal

screen capture method and the voice recorded message method combine the power of automatic

fixed menugeneration with the expanded flexibility to resolve operational issues that exist

throughout the hospitality market without this innovative solution. Additionally, in certain

embodiments, hand-writing and voice recognition technologies can be utilized to convert the

manual operator inputs into appropriate text messages which can be combined with the

computer generated menu options to convey the combined information to, for example, a

bartender or chef.
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Similarly, hand-held devices can link the above innovations to individual

customers at specific tables through a graphical user interface on the hand-held screen that

assigns each customer a number within a table. For example, table 20 might have 6 customers (1-

6) and each customer has a different order, By enabling the linkage of the orders to specific

customer positions within the table and accessible from the hand-held screen, the servers can

easily track and link the specific orders to the specific customers.

The use of wireless handheld devices in the restaurant and hospitality industry is

becoming increasingly pervasive as restaurant owners and managers become more aware of the

benefits. With the proper wireless handheld system in place, restaurants can experience

increased table turns from improved server productivity and shorter order taking and check

paying times. Restaurants and POS companies seeking to provide a wireless handheld interface

to their desktop-based POS systems or a Web page equivalent face several challenges. These

challenges include building a menu using their existing database and transferring the menu onto

handheld devices or Web pages that will interface with servers wirelessly 'or to

restaurants/customers over the intemet. The menu generation approach of the present invention

is the first coherent solution available to accomplish these objectives easily and allows one

development effort to produce both the handheld and Web page formats, link them with the

existing POS systems, and thus provides a way to turn a complicated, time-consuming task into a

simple process.

The information management and synchronous communications system of the

present invention features include fast synchronization between a central database and multiple

handheld devices, synchronization and communication between a Web server and multiple

handheld devices, a well-defined API that enables third parties such as POS companies, affinity
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program companies and intemet content providers to fully integrate with computerized

hospitality applications, real-time communication over the intemet with direct connections or

regular modem dialup connections and support for batch processing that can be done periodically

throughout the day to keep multiple sites in synch with the central database.

The communication module also provides a single point of entry for all hospitality

applications, e.g., reservations, frequent customer ticketing, wait lists, etc. to communicate with

one another wirelessly and over the Web. This communication module is a layer that sits on top

of any communication protocol and acts as an interface between hospitality applications and the

communication protocol and can be easily updated to work with a new communication protocol

without modifying the core hospitality applications. An exemplary system diagram of such a

communications systemic relationship is shown in Figure 9 and serves as an example of the

power of the synchronization element of the invention through a common, linked solution. A

single point of entry works to keep all wireless handheld devices and linked web sites in synch

with the backoffice server applications so that the different components are in equilibrium at any

given time and an overall consistency is achieved. For example, a reservation made online can

be automatically communicated to the backoffice server and then synchronized with all the

wireless handheld devices wirelessly. Similarly, changes made on any of the wireless handheld

devices are reflected instantaneously on the backoffice server Web pages and the other handheld

devices.

BRIEF DESCRIPTION OF THE DRAWINGS

The foregoing features and advantages of the present invention can be appreciated

more fully from the following description, with references to the accompanying drawings in

which:
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FIG. 1 is a schematic representation of a window displayed on a computer display

screen which shows a hierarchical tree menu, modifier window and sub-modifier window in

conformity with a preferred embodiment of the present invention.

FIG. 2 is a schematic representation of a modifier dialog box in conformity with a

preferred embodiment of the present invention.

FIG. 3 is a schematic representation of a menu category dialog box in conformity

with a preferred embodiment of the present invention.

FIG. 4 is a schematic representation of a menu item dialog box in conformity with

a preferred embodiment of the present invention.

FIG. 5 is a schematic representation of a display customization dialog box in

conformity with a preferred embodiment of the present invention.

FIG. 6 is a schematic representation of a communications control window in

conformity with a preferred embodiment of the present invention.

FIG. 7 is a schematic representation of a point of sale interface on a wireless

handheld device for use in displaying page menus created in conformity with a preferred

embodiment of the present invention.

FIG. 8 is an example of a literal, hand-written screen according to embodiments

of the present invention.

FIG. 9 is an exemplary system diagram relating to embodiments of the present

invention.

DETAILED DESCRIPTION OF THE INVENTION

Most personal computers today run under an operating system that provides a

graphical user interface (“GUI”) for accessing user applications. A GUI is used in the preferred
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embodiment of the present invention. Through an interface of windows, pull-down menus, and

toolbars, GUI operating systems have simplified PCs and have rendered computer technology

more user friendly by eliminating the need to memorize keyboard entry sequences. In addition,

GUIs allow users to manipulate their data as they would physical entities. For example, a

window can represent a file and the contents of the window can represent the records of the file.

The window can be opened, closed, or set aside on a desktop as if it were an actual object. The

records of the file can be created, deleted, modified and arranged in a drag-and-drop fashion as if

they also were physical objects. The most common GUI operating systems that provide this

“object-oriented” environment for personal computers are Microsoft Windows® systems,

including Windows CE® for handheld wireless devices and the like. Generally, a particular

application program presents. information to a user through a window of a GUI by drawing

images, graphics or text within the window region. The user, in turn, communicates with the

application by “pointing” at graphical objects in the window with a pointer that is controlled by a

hand-operated pointing device, such as a mouse, or by pressing keys on a keyboard.

The use of menus is conventional in GUIs for software applications. Menus are

typically utilized to provide end users of applications with available choices or processing

options while using the applications. For example, in a typical desktop or interactive application,

selection of a “file” from a menu bar may cause display of a context menu which provides “file”

options. File options can have additional subordinate or child options associated with them. If a

file option having subordinate options is selected, the child options are displayed in context in a

child menu or submenu proximate to the selected parent option. One or more of the child

options provided in the child menu may have further subordinate options. Thus, such a menu

system comprises cascading sets of menus which are displayable in context to show the
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parent/child relationships between options of the context menu. A menu system of this type is

incorporated into the preferred embodiment of the invention.

The preferred embodiment of the present invention uses typical hardware

elements in the form of a computer workstation, operating system and application software

elements which configure the hardware elements for operation in accordance with the present

invention. A typical workstation platform includes hardware such as a central processing unit

(“CPU”), e.g., a Pentium® microprocessor, RAM, ROM, hard drive storage in which are stored

various system and application programs and data used within the workstation, modem, display

screen, keyboard, mouse and optional removable storage devices such as floppy drive or a CD

ROM drive. The workstation hardware is configured by software including an operating system,

e.g., Windows® 95, 98, NT or CE, networking software (including intemet browsing software)

and application software components. The preferred embodiment also encompasses a typical file

server platform including hardware such as a CPU, e.g., Pentium® microprocessor, RAM, ROM,

hard drive, modem, and optional removable storage devices, e.g., floppy or CD ROM drive. The

server hardware is configured by sofiware including an operating system, e.g., Windows® 95, 98,

NT or CE, networking software (including Web server software) and database softWare.

A computer workstation for use in the preferred embodiment also includes a GUI.

As is conventional, the GUI is configured to present a graphical display on the display screen

arranged to resemble a single desktop. Execution of an application program involves one or

more user interface objects represented by windows and icons. Typically, there may be several

windows and icons simultaneously present on the desktop and displaying information that is

generated by different applications.
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The window environment is generally part of the operating system sofiware that

includes a collection of utility programs for controlling the operation of the computer system.

The computer system, in turn, interacts with application programs to provide higher level

functionality, including a direct interface with the user. Specifically, the application programs

make use of operating system functions by issuing task commands to the operating system which

then performs the requested task. For example, an application program may request that the

operating system display certain information on a window for presentation to the user.

An aspect of the preferred embodiment of the information management and

communications system of the invention is shown in FIG. 1. FIG. 1 shows an example of the

GUI provided by the operating system of the preferred embodiment of the present invention.

With reference to FIG. 1, the preferred embodiment includes an intuitive GUI 1 from which to

build a menu on a desktop or other computer. A hierarchical tree structure 2 is used to show the

different relationships between the menu categories 3 (e.g., soups, salads, appetizers, entrees,

deserts, etc.), menu items 4 (e.g., green salad, chicken caesar salad, etc.), menu modifiers 5 (e.g.,

dressing, meat temperature, condiments, etc.) and menu sub-modifiers 6 (e.g., Italian, French,

ranch, bleu cheese, etc.).

The procedure followed in configuring a menu on the desktop PC and then

downloading the menu configuration onto the POS interface on the handheld device in

conformance with the preferred embodiment is as follows.

The menu configuration application is launched by clicking on the appropriate

icon on the desktop display screen. FIG. 1 will then be displayed. There are three windows on

the screen shown in FIG. 1. The left window is the menu tree 7, also called the tree view. The

top right window is the Modifiers window 8 and the bottom right window is the Sub-Modifiers
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window 9. The Sub-Modifiers window lists the sub-modifiers that correspond to the modifier

that is selected. The views on the right are referred to as list views. There are several ways of

invoking a command, including using the menu options; using the context menu (right mouse

click); using the keyboard or using the toolbar icons. For example, if it is desired to add a

category to the menu, the following four options are available: (1) clicking on Edit, Add

Category; (2) right mouse clicking on Menu, then clicking on Add Category; (3) highlighting

Menu, then typing Ctrl + T or (4) clicking on the Add Category icon on the toolbar. To add an

item to a category, the following options are available: (1) highlighting the category to which it

is desired to add an item and then clicking on Edit > Add Item; (2) right mouse clicking on the

desired category and then clicking on Add Item; (3) highlighting the desired category, then

typing Ctrl + N or (4) clicking on the Add icon on the toolbar.

When building a menu, it should be kept in mind that the menu items are stored

using a tree metaphor similar to how files are stored on a PC with folders and subfolders. The

menu structure is similar to the Windows® File Explorer in the way the items are organized

hierarchically. Below is an example of how an item may be configured:

Menu

>> Entrees

>> Red Meat

>> NY Strip

>> Vegetables
>> Tomato

>> Lettuce

Meat Temperature
>> Medium Rare

In the above example, Menu is the root. Entrees is a menu category. Red Meat is an Entree

category. NY Strip is a modifier. Vegetable is a modifier. Meat Temperature is a modifier.

Medium Rare is a sub-modifier of Meat Temperature.
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The steps taken in building a menu are as follows:

Add Modifiers;

Add Sub-Modifiers and link them to the Modifiers;

Create Menu categories;

Add menu items to the categories;

Assign Modifiers to the menu items;

Preview the menu on the POS emulator on the desktop PC;

Download the menu database to the handheld device.

Np‘V‘PP’N?‘
To add modifiers, a user clicks on the inside of the Modifiers window, then (1)

clicks on Edit>Add Modifier; (2) Presses Ctrl + N; (3) right mouse clicks in the Modifiers

window, then clicks on Add Modifiers or (4) clicks on the Add icon from the toolbar. If a menu

is being built from scratch, the procedure is to enter the Long Name, Short Name, Code and

Price in the Modifier dialog box 10 shown in FIG. 2. The Long Name is the full descriptive

name of the item. The Short Name is the abbreviated name that will be displayed on the

handheld device. The Code is the numeric or alphanumeric code for the item. If there is an

existing database, the existing database can be browsed and menu items retrieved from the

database. Clicking on the Browse button will bring up the existing database of menu items. The

item to be added is then selected and “OK” is clicked. The fields will then be filled with the

information from the database. Clicking on OK again will add the item as a modifier. To delete

a modifier,the modifier is selected and the Delete key pressed on the keyboard. To edit a

modifier, either the modifier is double clicked or the Enter key is pressed.

Sub-modifiers represent the last level of modifiers that can be assigned to a menu

tree. To add sub-modifiers, the modifier to which sub-modifiers are to be assigned is selected.

Then, the focus is set on the sub-modifier window by clicking inside the Sub—Modifier window

as follows: (1) clicking on Edit>Add Sub-Modifier; (2) pressing Ctrl + N; (3) right mouse
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clicking in the Sub-Modifiers window, then clicking on Add Sub-Modifiers or (4) clicking on the

Add icon from the toolbar. If a menu is being built from scratch, the procedure is to enter the

Long Name, Short Name, Code and Price in a Sub—Modifier dialog box similar to the Modifier

dialog box shown in FIG. 2. As with modifiers, the Long Name is the full descriptive name of

the item. The Short Name is the abbreviated name that will be displayed on the handheld device.

The Code is the numeric or alphanumeric code for the item. As before, if there is an existing

database, the existing database can be browsed and menu items retrieved from the database.

Clicking on the Browse button will bring up the existing database of menu items. The item to be

added is then selected and OK clicked. The fields will then be filled with the information from

the database. Clicking on OK again will add the item as a sub-modifier. To delete a sub-

modifier, the sub-modifier is selected and the Delete key depressed on the keyboard. To edit a

sub-modifier, either the sub-modifier is double clicked or the Enter key is pressed.

Menu categories are created from the root. Some examples of categories are

Appetizers, Soups, Salads, Entrees, Desserts, etc. The first step is to click on Menu in the menu

tree window. Categories are added by (1) clicking on the Add Category icon from the toolbar;

(2) clicking on Edit > Add Category or (3) pressing Ctrl + T. As shown in FIG. 3, Menu

Category dialog box 11 then appears in which to enter the Long and Short names for the menu

category.

To add menu items to categories, the menu category which is being built is

clicked. For example, if items are being added to Appetizers, the Appetizers branch is clicked

on. Then the Edit > Add Item is clicked on or Ctrl + N pressed. As before, if a menu is being

built from scratch, the procedure is to enter the Long Name, Short Name, Code, Prep Time,

Recipe and Price into the Menu Item dialog box 12 shown in FIG. 4. The Long Name is the full
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descriptive name of the item. The Short Name is the abbreviated name that will be displayed on

the handheld device. The Code is the numeric or alphanumeric code for the item. Prep Time is

the time it takes to prepare the meal and Recipe would include preparation methods and

ingredients that are used in the preparation of the item. If there is an existing database, the

existing database can be browsed and menu items retrieved from the database. Clicking on the

Browse button will bring up the existing database of menu items. The item to be added is then

selected and OK is clicked. The fields will then be filled with the information from the database.

Clicking on OK again will add the item to the category.

Once the menu items have been entered, it may be desired to assign some

modifiers to the menu items. For example, it may be desired to assign meat temperature to a

steak order. To accomplish this, first the modifier to be assigned is selected, then the menu item

on the tree view that is to be assigned the modifier is clicked on and then Edit > Assign Modifier

is clicked on. Or, the modifier can simply be dragged and dropped onto the menu item to link

them. A dialog box is then displayed asking if this modifier is a required modifier. If it is a

required modifier, the display icon will be red but if it is a non-required modifier the display icon

will be green. As many modifiers as are applicable can be assigned. If any changes are made to

the modifiers, those changes will be automatically reflected throughout the menu tree.

Once the modifiers have been entered, it may be desired to assign sub-modifiers

to the modifiers items. For example, it may be desired to add Honey Mustard as a sub-modifier

to Dressing. To accomplish this, first the modifier to be assigned a sub-modifier is selected, then

the sub-modifier window is clicked on, then Edit > Add Sub Modifier is clicked on, Ctrl+N

entered or the Add icon from the toolbar is clicked on. Or, the sub-modifier can simply be

dragged and dropped onto the modifier to link them.
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When the menu has been completely configured, it can be previewed on a POS

emulator on the desktop to verify that the menu is correctly configured before downloading it to

the handheld device. To preview, File > Preview Database is clicked on or the Preview Database

icon from the toolbar is clicked on. The handheld POS emulator on the desktop can then be run.

If the configuration is deemed acceptable, the handheld device is connected to the desktop PC to

ensure that a connection has been established; the POS application on the handheld device is

exited and File > Download Database is clicked on or the Download Database icon from the

toolbar is clicked on. If there is an existing menu database on the handheld device, the system

will ask if the existing database should be replaced. Yes is clicked if existing database

replacement is desired.

A database function enables the creation of, e.g., a breakfast menu, lunch menu

and dinner menu and downloading them to a handheld device. Functions available are (1)

creating a new database; (2) opening an existing database; (3) saving a database under a different

name. To access these functions, File is clicked on the menu bar.

The preferred embodiment encompasses customized layout, views and fonts. To

set the focus on the view it is desired to change, click inside the desired window. The main

customizing dialog box is accessed by clicking on View > Customize View. A dialog box 13, as

shown in FIG. 5, will be displayed including tabs that allow the following options: selection of

Columns to display in the list view by choosing and arranging the fields to display in the

Modifiers and Sub-Modifiers windows; formatting Columns by specifying the column widths

and justification; selecting Filter allows restricting the list to display only the items that meet

certain criteria. For example, display of modifiers with codes between 500 and 550. Selecting

Sort allows sorting the modifiers or sub-modifiers according to any of the available fields such as

-19-

914001 vl

Apple, Exhibit 1008, Page 29



Apple, Exhibit 1008, Page 30

10

11

12

13

14

15

16

17

18

19

20

21

22

23

Attorney Docket No. 3125—4003US]

Name, Code or Price. Selecting Style facilitates choice of font type, style, size, etc. To change

the font in a particular window, click on View > Fonts or right mouse click in the desired

window and then click on Fonts. To change the size of the windows, drag the borders of the

windows to expand or contract the size of the windows. To change the column widths, simply

drag the edge of the column headers to increase or decrease the column widths.

A communications control program monitors and routes all communications to

the appropriate devices. It continuously monitors the wireless network access point and all other

devices connected to the network such as pagers, remote devices, intemet Web links and POS

software. Any message received is decoded by the software, and then routed to the appropriate

device. No user action is needed during operation of the software once the application has been

launched. To launch the communications control module, a Wireless Traffic icon is clicked on

the desktop PC. When the program loads, the screen shown in FIG. 6 appears. Messages

received are logged in the window 14 shown in FIG. 6 with a time stamp. The messages are also

logged to a file on the hard drive. This provides a mechanism to monitor all traffic across the

network (possibly usefiJl for troubleshooting, or maintenance, but not necessary fornormal

operation). The program may be minimized so the screen is not displayed on the desktop, but it

must be running for proper communications to exist between all devices on the network.

As stated, the preferred embodiment of the present invention includes the use of

and compatibility with GUI technology. A drag-and-drop approach is used for organizing the

tree structure 2 in the generated menu. Drag-and-drop is also used for assigning modifiers

(modifiers can be dragged from the modifiers window 5 and dropped onto the menu item 4 for

assignment). In—cell editing results in fast editing of items in building the menus. Customizable

fonts enable users to change font types, style and size. Customizable layouts enable users to
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resize windows, change icons and display preferences. The inventive approach provides for

fully persistent storage between sessions, even if a session is improperly or abruptly terminated.

Font and the tree state (i.e., which nodes are expanded/collapsed) are stored between sessions.

Layout for modifiers and sub-modifiers list views (filter, columns, formatting, font, etc.) are

stored between sessions. The last database used is likewise stored between sessions. Splitter

views allow the user to see different views at the same time. Each View is displayed on its own

section of the screen. Views can be resized via the keyboard or a mouse by simply dragging the

splitter in the middle.

An automated function is provided to import existing POS databases into the

inventive menu generation system and, as discussed above with respect to the detailed example

of how to use the preferred embodiment, an automated download procedure is provided to

transfer the desktop database onto a handheld device and/or Web page. Also as discussed, the

preferred embodiment facilitates preview of the handheld device or Web page version of the

POS menu on the desktop before downloading and configuration. Customizable desktop menu

generation is contemplated, as discussed above, in the form of customizable fonts, columns,

layouts, etc. The inventive approach also includes templates for common modifiers that can be

assigned to similar menu items. The preferred embodiment also supports multiple databases,

thus providingfor the creation and storing of different menu databases on handheld devices such

as breakfast, lunch or dinner menus. The user can then select the appropriate database to reflect

the time of day.

FIG. 7 is a schematic representation of a point of sale interface 15 for use in

displaying a page-type menu 16 created using the inventive menu generation approach. As can

be seen from FIG. 7, the page menu is displayed in a catalogue-like point-and-click format
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whereas the master menu, FIG. 1, is displayed as a hierarchical tree structure. Thus, a person

with little expertise can “page through” to complete a transaction with the POS interface and

avoid having to review the entire menu of FIG. 1 to place an order. A PDA or Web page format

could appear like FIG. 7 or the display could be configured for particular requirements since

fully customizable menu generation and display are contemplated.

The POS interface on the handheld device supports pricing in the database or

querying prices from the POS server. The POS device also can be customized with respect to

“look and feel” for the particular version. As can be seen in FIG. 7, the POS interface provides

for billing, status and payment with respect to orders. A myriad of options can be provided

depending on the application.

Advanced database functions are provided in the preferred embodiment of the '

invention, including an automated download process onto handheld devices and/or Web sites. In

the preferred embodiment, the menu generation system of the present invention uses an API

called ActiveX Data Objects (“ADO”) for database access. ADO is useful in a variety of

settings. It is built on top of OLE DB and can be used to talk to databases and, in the future, any

data source with any OLE DB driver. Advanced querying is supported. The database can be

queried on virtually all fields. Queries can be built using SQL syntax for experienced users or

can be created using a query builder which guides users through the creating process. Advanced

error handling is supported. Errors occurring at run time can be trapped. A descriptive message

is displayed to alert the user and provide error information. However, the application does not

terminate when the errors happen. The source code is easy to maintain and modify, thus

allowing for on time delivery of customized versions of the software. The advanced database

functions produce well-designed databases that accommodate growth and scalability
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The inventive menu generation approach provides a solution for the pervasive

connectivity and computerization needs of the restaurant and related markets. The inventive

solution includes automatic database management and synchronization, PDA and handheld

wireless operating system integration and optimization, wireless communications and intemet

connectivity, user interface design, and graphics design.

In the preferred embodiment, the menu generation approach of the present

invention uses Windows CE® as the operating system for the handheld devices. Windows CE®

provides the benefits of a familiar Windows 95/98/NT® look and feel, built-in synchronization

between handheld devices, intemet and desktop infrastructure, compatibility with Microsoft

Exchange®, Microsoft Office 9® and TCP/IP quick access to information with instant-on feature.

Windows CE® provides a basic set of database and communication tools for

developer use. However, interfacing with these tools to provide application specific results can

be a complex task. In addition to the menu generation described above, a set of software

libraries described herein in conformance with the present invention not only enhances the basic

Windows CE® functionality by adding new features but also maximizes the full potential of

wireless handheld computing devices. Such features include fast synchronization between a

central database and multiple handheld devices, synchronization and communication between a

Web server and multiple handheld devices, a well-defined API that enables third parties such as

POS companies, affinity program companies and intemet content providers to fully integrate

with computerized hospitality applications, real-time communication over the intemet with direct

connections or regular modem dialup connections and support for batch processing that can be

done periodically throughout the day to keep multiple sites in synch with the central database.
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The synchronous communications control module discussed above provides a

single point of entry for all hospitality applications to communicate with one another wirelessly

or over the Web. This communications module is a layer that sits on top of any communication

protocol and acts as an interface between hospitality applications and the communication

protocol. This layer can be easily updated to work with a new communication protocol without.

having to modify the core hospitality applications. The single point of entry works to keep all

wireless handheld devices and linked Web sites in synch with the backoffice server (central

’ database) so that the different components are in equilibrium at any given time and an overall

consistency is achieved. For example, a reservation made online is automatically communicated

to the backoffice server which then synchronizes with all the wireless handheld devices

wirelessly. Similarly, changes made on any of the wireless handheld devices will be reflected

instantaneously on the backoffice server and the other handheld devices.

The software applications for performing the functions falling within the

described invention can be written in any commonly used computer language. The discrete

programming steps are commonly known and thus programming details are not necessary to a

full description of the invention. 1

A simple point-to-point wireless capability is contemplated which permits simple

digital messages to be sent from the wireless handheld devices to a receiver in a beeper and/or

valet parking base-station. The POS interface of FIG. 7 is representative of the display on a

typical wireless device used in conformity with the invention. A simple protocol is used to

acknowledge receipt of the message and thus simultaneous communication is not necessary,

which reduces the cost of the wireless link. The range of the wireless link is determined by the

characteristics of the radio transceiver. Adding a wireless link allows paging of beeper equipped
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customers directly from the operator interface on the wireless handheld devices and

communication to and fiom various input/output transmitters and receivers to update the status

of the order, reservation or other information and thus further reduce the workload on the

operator and enable operations to proceed much faster. This link could also be hardwired or

otherwise implemented using any two-way messaging transport.

A further aspect of the invention is the use of the menus generated in accordance

with the described technique to place orders from wireless remote handheld devices or from

remote locations through the intemet. The World Wide Web is a distributed hypermedia

computer system that uses the intemet to facilitate global hypermedia communication using

specified protocols. One such protocol is the Hypertext Transfer Protocol (“HTTP”), which

facilitates communication of hypertext. Hypertext is the combination of information and links to

other information. In the context of the Web, hypertext is defined by the Hypertext Mark—up

Language (“HTML”). The links or hyperlinks in a HTML document reference the locations of

resources on the Web, such as other HTML documents. Another language used in creating

documents for use on the Worldwide Web, to display on computer screens, or to create speech

style sheets for use in, e.g., telephones, is the Extensible Mark-Up Language (“XML”). XML is

a “metalanguage”, i.e., a language for describing languages which was developed to eliminate

the restrictions of HTML.

The Web is a client-server system. The HTML documents are stored on Web

server computers, typically in a hierarchical fashion with the root document being referred to as

the home page. The client specifies a HTML document or other source on the server by

transmitting a Uniform Resource Locator (“URL”) which specifies the protocol to use, e.g.,

HTTP, the path to the server directory in which the resource is located, and filename of the
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resource. Users retrieve the documents via client computers. The software running on the user’s

client computer that enables the user to view HTML documents on the computer’s video monitor

and enter selections using the computer’s keyboard and mouse is known as a browser. The

browser typically includes a window in which the user may type a URL. A user may cause a

URL to be transmitted by typing it in the designated window on the browser or by maneuvering

the cursor to a position on the displayed document that corresponds to a hyperlink to a resource

and actuating the mouse button. The latter method is commonly referred to simply as “clicking

on the hot-spot” or “clicking on the hyperlink”. The hyperlink methodology is contemplated for

use in accordance with the preferred embodiment to transmit orders via the intemet.

Web server application software exists that enables a user to shop for and order

merchandise. Such systems are sometimes referred to as electronic merchandising systems or

virtual storefronts. Systems that enable a user to choose among several retailers’ goods are

sometimes referred to as electronic malls. An electronic retailer’s or electronic mall operator’s

Web server provides HTML forms that include images and descriptions of merchandise. The

user may conventionally search for an item by entering a key word search query in a box on a

form. When a user selects an item, the server may provide a linked form that describes that item

in further detail. The user may also conventionally enter ordering information into boxes on the

form, such as the type and quantity of the item desired. The information entered by the user is

transmitted to the server. The user may select multiple items in this manner and then enter a

credit card number to pay for the purchases. The retailer processes the transaction and ships the

order to the customer. As can be appreciated, ordering merchandise can also be done from

menus. The generation of menus of items or merchandise for sale over the intemet is readily

accomplished by the menu generation approach of the present invention.
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Searching for items that the user is interested in purchasing is insufficient in prior

merchandising systems. Database management programs use index searching to facilitate rapid

searching of large amounts of data. The creator of the database may instruct the program to use

specified fields in the database as indexed or key fields. The program locates all terms in the

database that appear in the indexed fields and stores them in an index table. Each entry in the

index table includes a term and corresponding pointer to the location in the database where the

term is found. If a user initiates a search for a term that is present in the index table, the program

can locate the instances of that term in the database with exceptional speed. Users who are

familiar with the particular database they are searching will generally know which fields are

indexed and will know the format of the data in those fields. For example, a user of a database

containing the inventory of a bookstore may know that users can search for the names of authors

of books and that a user who wishes to do so should enter the author’s last name first. A user

having such knowledge will therefore be able to search efficiently. Users of electronic

merchandising systems, however, are generally end-consumers who have no knowledge of a

merchant’s database. If, as is very likely, such a user initiates a search for a term that is not

present in the index table, the program must sequentially search through all records in the

database. Sequential records are typically linked by pointers. Using pointers in this manner is

very demanding on server resources, resulting not only in an exceptionally slow search, but also

creating a bottleneck for other processes that the server may be executing. The menu generation

approach of the present invention can be used to create customized menus from a database that

includes every item of merchandise the vendor has for sale. In this manner, customers can scan

the generated menu much more readily than they could view the entire database and the
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necessity of having familiarity with the database is eliminated as well, reducing the need for

resource intensive pointers.

While the preferred embodiment of the invention is for the generation of

restaurant menus and the like, the broad scope of the invention is far greater. For example,

menus generated in accordance with the invention can be used in the desktop computing

environment in association with the operating system or application programs. One such use is

to facilitate the creation of user personalized file structures for general desktop use. Another use

is to facilitate the location of customized menus from master menus for use in association with

application software to make the execution of the application software more efficient by, e.g.,

eliminating the necessity of querying or checking every tree branch in the master menu file

structure in response to user input or other criteria and to create handheld/FDA compatible

versions of the software.

While the preferred embodiment of the invention includes the selection of items

from a master menu wherein the master menu is displayed using a graphical user interface, it is

to be appreciated that any means for displaying the master menu to the user and generating

another menu in response to and comprised of the selections made is encompassed by the

contemplated invention. The invention encompasses the selection of nontextual symbols,

characters, icons and the like, in addition to text, from a hierarchical tree menu or the like for

generation of another menu comprised of such items.

It is also within the scope of the invention to generate menus automatically in

response to predetermined criteria. For example, in the restaurant menu generation embodiment,

a modified menu can be generated to comply with a particular specification or group of criteria

such as, e.g., “dinner”, “low cholesterol”, “low fat”, “fish”, “chicken”, or “vegetarian”. In this
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embodiment, only items from the master menu that satisfy specified parameters will be included

in the generated menu. The selection process could involve selection of master menu items

based on tags or identifiers associated with the items or by checking every master menu item

against a dictionary of items acceptable for inclusion in the modified menu. It should also be

appreciated that the invention encompasses any combination of automatic and manual user

selection of the items comprising the generated menu. For example, a user might specify criteria

which would further control automatic selection or the user could manually select some items

with automatic selection of others. The menu generation aspect of the invention is equally

applicable to table-based, drive-thru, intemet, telephone, wireless or other modes of customer

order entry, as is the synchrOnous communications aspect of the invention.

The inventive concept encompasses the generation of a menu in any context

known to those skilled in the art where an objective is to facilitate display of the menu so as to

enable selection of items from that menu. The restaurant menu generation embodiment is but

one example of a use for the inventive concept. Likewise, displaying menus generated in

accordance with the invention on PDAs and Web pages to facilitate remote ordering are but a

few examples of ways in which such a menu might be used in practice. Any display and

transmission means known to those skilled in the art is equally usable with respect to menus

generated in accordance with the claimed invention.

In the more general situation, menus can be generated in accordance with the

present invention in a variety of situations. For example, the usable file structure for a particular

data processing application can be dictated by the user or an application program prior to or

during the execution of the application program. Efficiencies with respect to computational
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speed and equipment, e.g., storage and processor, usage can thus be achieved along with the

facilitation of display of the generated menu.

While the best mode for carrying out the preferred embodiment of the invention

has been illustrated and described in detail, those familiar with the art to which the invention

relates will recognize various alternative designs and embodiments which fall within the spirit of

practicing the invention. The appended claims are intended to cover all those changes and

modifications falling within the true spirit and scope of the present invention.
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That which is claimed is:

1. .An information management and synchronous communications system for

generating and transmitting menus comprising:

a. a central processing unit,

b. a data storage device connected to said central processing unit,

c. an operating system including a graphical user interface,

(1. a first menu consisting of menu categories, said menu categories

consisting of menu items, said first menu stored on said data storage device and displayable in a

window of said graphical user interface in a hierarchical tree format,

e. a modifier menu stored on said data storage device and displayable in a

window of said graphical user interface,

1'. a sub-modifier menu stored on said data storage device and displayable in

a window of said graphical user interface, and

g. application software for generating a second menu from said first menu

and transmitting said second menu to a wireless handheld computing device or Web page,

wherein the application sofiware facilitates the generation of the second menu by

allowing selection of categories and items from the first menu, addition of menu categories to the

second menu, addition of menu items to the second menu and assignment of parameters to items

in the second menu using the graphical user interface of said operating system, said parameters
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being selected from the modifier and sub-modifier menus, wherein said second menu is manually

modified afier generation.

2. An information management and synchronous communications system for

generating menus comprising:

a. a central processing unit,

b. a data storage device connected to said central

processing unit,

c. an operating system including a graphical user

interface,

(1. a first menu stored on said data storage device,

e. application software for generating a second menu

from said first menu,

wherein the application software facilitates the generation of the second menu by

allowing selection of items from the first menu, addition of items to the second menu and

assignment of parameters to items in the second menu using the graphical user interface of said

operating system and wherein data comprising the second menu is synchronized between the

data storage device connected to the central processing unit and at least one other computing

device, wherein said second menu is manually modified by handwriting or voice recording after

generation.
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3. An information management and synchronous communications system for

generating menus comprising:

a. a microprocessor,

b. a display device,

c. a data and instruction input device,

(1. a data storage device for storing information and

instructions entered through said data and

instruction input means or information generated by

said microprocessor,

e. an operating system,

f. a master menu stored on said data storage device for

generating a modified menu, and

g. application software,

wherein said microprocessor, operating system and application software are operative to display

the master menu on the display device in response to instructions programmed into said

microprocessor, operating system, application software and information and instructions entered

through said data input device, and wherein said microprocessor, operating system and

application software are operative to create the modified menu from said master menu in

response to information and instructions entered through said data and instruction input device

and wherein data comprising the modified menu is synchronized between the data storage device
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and at least one other computing device, wherein said modified menu is manually modified afier

generation.

4-. In a computer system having an input device, a storage device, a video display,

an operating system including a graphical user interface and application software, an information

management and synchronous communications method comprising the steps of:

914001vl

a.
outputting at least one window on the video display;

outputting a first menu in a window on the video

display;

displaying a cursor on the video display;

selecting items from the first menu with the input

device or the graphical user interface;

inserting the items selected from the first menu into

a second menu, the second menu being output in a

window;

optionally adding additional items not included in

the first menu to the second menu using the input

device or the graphical user interface;

storing the second menu on the storage device; and
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synchronizing the data comprising the second menu between the storage device

and at least one other data storage medium, wherein the other data storage medium is connected

to or is part of a different computing device, and wherein said second menu is manually modified

afier generation.

5. The information management and synchronous communications system of

claim 1, 2, or 3 wherein the manual modification involves handwriting capture.

6. The information management and synchronous communications

system of claim 1, 2, or 3 wherein the manual modification involves voice capture.

7. The method of claim 4 wherein the manual modification involves

handwriting capture.

8. The method of claim 4 wherein the manual modification involves voice

capture.

9. The system of claim 1 wherein the modified second menu can be

selectively printed on any printer directly from the graphical user interface of a hand-held device.

10. The system of claim 1 wherein the modified second menu can be linked to

a specific customer at a specific table directly from the graphical user interface of a hand-held

device.
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11. The system of claim 2 or 3 wherein the modified second menu can be

selectively printed on any printer directly from the graphical user interface of said other

computing device.

12. The system of claim 2 or 3 wherein the modified second menu can be

linked to a specific customer at a specific table directly from the graphical user interface of said

other computing device.

13. The system of claim 5 wherein the handwriting capture involves

handwriting recognition and conversion to text.

14. The system of claim 6 wherein the voice capture involves voice

recognition and conversion to text.

15. The method of claim 7 wherein the handwriting capture involves

handwriting recognition and conversion to text.

16. The method of claim 8 wherein the voice capture involves voice

recognition and conversion to text.
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ABSTRACT

An information management and synchronous communications system and

method facilitates database equilibrium and synchronization with wired, wireless and Web-based

systems, user-friendly and efficient generation of computerized menus and reservations with

handwritten/voice modifications for restaurants and other applications that utilize equipment

with nonstandard graphical formats, display sizes and/or applications for use in remote data

entry, information management and communication with host computer, digital input device or

remote pager via standard hardwired connection, the intemet, a wireless link, printer or the like.
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the invention entitled: ‘

INFORMATION MANAGEMENT AND SYNCHRONOUS COMMUNICATIONS SYSTEM WITH MENU
GENERATION“a

the specification of which
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b. [X] was filed on September 21, 1999 as application Serial No. 09/400,413 and was amended on
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same subject matter having a filing date within twelve (12) months before that of the application on which priority is
claimed: '

[ ] The attached 35 U.S.C. § 1 19 claim for priority for the application(s) listed below forms a part of this
declaration.
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Application Date of filing Date of Issue Priority

Country/PCT Number (day, month, )1) (day, month, yr) Claimed

YES NO

YES NO

YES NO

[ ] I hereby claim the benefit under 35 U.S.C. § 119(e) of any US. provisional application(s) listed below.

Provisional Application No. Date of Filing (day, month, )1)

ADDITIONAL STATEMENTS FOR DIVISIONAL, CONTINUATION OR CONTINUATION-IN-PART

OR PCT INTERNATIONAL APPLICATIONS) (DESIGNATING THE US.)

I hereby claim the benefit under Title 35, United States Code § 120 of any United States application(s) or under
§ 365(c) of any PCT international application(s) designating the US. listed below.

US/PCT Application Serial No. Filing Date Status (patented, pending, abandoned)/

US. application no. assigned (For PCT)

US/PCT Application Serial No. Filing Date Status (patented, pending, abandoned)/

US. application no. assigned (For PCT)

[ ] In this continuation—impart application, insofar as the subject matter of any of the claims of this

application is not disclosed in the above listed prior United States or PCT international application(s) in the manner

provided by the first paragraph of Title 35, United States Code, § 112, I acknowledge the duty to disclose material

information as defined in Title 37, Code of Federal Regulations, § 1.56(a) which occurred between the filing date of

the prior application(s) and the national or PCT international filing date of this application.

I hereby declare that all statements made herein of my own knowledge are true and that all statements made on

information and belief are believed to be true; and further that these statements were made with the knowledge that
willful false statements and the like so made are punishable by fine or Imprisonment, or both, under Section 1001 of

Title 18 of the United States Code and that such willful false statements may jeopardize the validity of the
application or any patent issued thereon.

I hereby appoint the following attorneys and/or agents with fiill power of substitution and revocation, to prosecute
this application, to receive the patent, and to transact all business in the Patent and Trademark Office connected

therewith: John A. Diaz (Reg. No. 19,550), John C. Vassil (Reg. No. 19,098), Alfred P. Ewert (Reg. No. 19,887),

-2-
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David H. Pfeffer (Reg. No. 19,825), Harry C. Marcus (Reg. No. 22,390), Robert E. Paulson (Reg. No. 21,046),

Stephen R. Smith (Reg. No. 22,615), Kurt E. Richter (Reg. No. 24,052), J. Robert Dailey (Reg. No. 27,434), Eugene
Moroz (Reg. No. 25,237), John F. Sweeney‘(Reg. No. 27,471), Arnold 1. Rady (Reg. No. 26,601), Christopher A.
Hughes (Reg. No. 26,914), William S. Feiler (Reg. No. 26,728), Joseph A. Calvaruso (Reg. No. 28,287), James W.

Gould (Reg. No. 28,859), Richard C. Komson (Reg. No. 27,913), Israel Blum (Reg. No. 26,710), Bartholomew

Verdirame (Reg. No. 28,483), Maria C.H. Lin (reg. No. 29,323), Joseph A. DeGirolamo (Reg. No. 28,595), Michael

P. Dougherty (Reg. No. 32,730), Seth J. Atlas (Reg. No. 32,454), Andrew M. Riddles (Reg. No. 31,657), Bruce D.
DeRenzi (Reg. No. 33,676), Michael M. Murray (Reg. No. 32,537), Mark J. Abate (Reg. No. 32,527), Alfred L.

Haffner, Jr. (Reg. No. 18,919), Harold Haidt (Reg. No. 17,509), John T. Gallagher (Reg. No. 35,516), Steven F.

Meyer (Reg. No. 35,613) and Kenneth H. Sonnenfeld (Reg. No. 33,285) of Morgan & Finnegan, L.L.P. whose
address is: 345 Park Avenue, New York, New York, 10154; and Edward A. Pennington (Reg. No. 32,588), Michael
S. Marcus (Reg. No. 31,727) and John E. Hoe] (Reg. No. 26,279) of Morgan & Finnegan, L.L.P., whose address is
1775 Eye Street, Suite 400, Washington, DC. 20006.

[ ] I hereby authorize the US. attorneys and/or agents named hereinabove to accept and follow instructions
from 

as to any action to be taken in the US. Patent and Trademark Office

regarding this application without direct cormnunication between the U.S attorneys and/or agents and me.

In the event of a changein the person(s) from whom instructions may be taken I will so notify the U.S
attorneys and/or agents hereinabove.

Keith R. McNall
 

 
 

Full name of sole or first inventor
 

Inventor’s signature“

Residence

Citizenship USA 

Post Office Address 

Full name of second joint inventor, if any William H. Roof

Inventor’s signature“ . i 6) 'Z 5/
date

Residence 13429 Luckett Court, San Die 0, CA 92130

 

 

Citizenship USA 

Post Office Address 

Full name of third joint ‘

Inventor’s signature“ 
Residence 20719 Nashvrlleeourt Chatsworth, CA 9.1 

Citizenship USA 

492351_1
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Post Office Address

[ ] ATTACHED IS/ARE ADDED PAGE(S) TO COMBINED DECLARATION AND POWER OF
ATTORNEY FORM FOR SIGNATURE BY FOURTH AND SUBSEQUENT INVENTORS

* Before signing this declaration, each person signing must:

1. Review the declaration and verify the correctness of all information therein; and

2. Review the specification and the claims, including any amendments made to the claims.

After the declaration is signed, the specification and claims are not to be altered.

To the inventor(s):

The following are cited in or pertinent to the declaration attached to the accompanying application:

Title 37, Code of Federal Regulation, § 1.56

Duty to disclose information material to patentability.

(a) A patent by. its very nature is affect with a public interest. The public interest is best served, and
the most effective patent examination occurs when, at the time an application is being examined, the Office
is aware of and evaluates the teachings of all information material to patentability. Each individual
associated with the filing and prosecution of a patent application has a duty of candor and good faith in
dealing with the Office, which includes a duty to disclose to the Office all information known to that

individual to be material to patentability as defined in this section. The duty to disclose information exists
with respect to each pending claim until the claim is canceled or withdrawn from consideration, or the
application becomes abandoned. Information material to' the patentability of a claim that is canceled or

withdrawn from consideration need not be submitted if the information is not material to the patentability
of any claim remaining under consideration in the application. There is no duty to submit information
which is not material to the patentability of any existing claim. The duty to disclose all information known
to be material to patentability is deemed to be satisfied if all information known to be material to

patentability of any claim issued in patent was cited by the Office or submitted to the Office in the manner

prescribed by §§1.97(b)-(d) and 1.98. However, no patent will be granted on an application in connection
with which fraud on the Office was practiced or attempted or the duty of disclosure was violated through
bad faith or intentional misconduct. The Office encourages applicants to carefully examine:

(1) prior art cited in search reports of a foreign patent office in a counterpart application, and

(2) the closest information over which individuals associated with the filing or prosecution of
a patent application believe any pending claim patentably defines, to make sure that any
material information contained therein is disclosed to the Office.

492351_1
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x... s.-

Title 35, US. Code § 101

Inventions patentable

Whoever invents or discovers any new and useful process, machine, manufacture, or composition of
matter, or any new and useful improvement thereof, may obtain a patent therefor, subject to the conditions and
requirements of this title.

Title 35 US. Code § 102

Conditions for patentability; novelty and loss of right to patent

A person shall be entitled to a patent unless —

(a) the invention was known or used by others in this country, or patented or described in a printed
publication in this or a foreign country, before the invention thereof by the applicant for patent,

(b) the invention was patented or described in a printed publication in this or foreign country or in
public use or on sale in this country, more than one year prior to the date of application for patent in the United
States, or

(c) he has abandoned the invention, or

(d) the invention was first patented or caused to be patented, or was the subject of an inventor’s
certificate, by the applicant or his legal representatives or assigns in a foreign country prior to the date of the
application for patent in this country on an application for patent or inventor’s certificate field more than twelve
months before the filing of the application in the United States, or

(e) the invention was described in a patent granted on an application for patent by another filed in the
United States before the invention thereof by the applicant for patent, or on an international application by another
who has fulfilled the requirements of paragraphs (1), (2), and (4) of section 371(c) of this title before the invention
thereofby the applicant for patent, or

(t) he did not himself invent the subject matter sought to be patented, or

(g) before the applicant’s invention thereof the invention was made in this country by another had not
abandoned, suppressed, or concealed it. In determining priority of invention there shall be considered not only the
respective dates of conception and reduction to practice of the invention, but also the reasonable diligence of one
who was first to conceive and last to reduce to practice, from a time prior to conception by the other

Title 35, US. Code § 103

Conditions for patentability; non-obvious subject matter

A patent may not be obtained though the invention is not identically disclosed or described as set forth in

section 102 of this title, if the differences between the subject matter sought to be patented and the prior art are such
that the subject matter as a whole would have been obvious at the time the invention was made to a person having
ordinary skill in the art to which said matter pertains. Patentability shall not be negatived by the manner in which
the invention was made.

Subject matter developed by another person, which qualifies as prior art only under subsection (0 or (g) of
section 102 of this title, shall not preclude patentability under this section where the subject matter and the claimed

-5-
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invention were, at the time the invention was made, owned by the same person or subject to an obligation of
assignment to the same person.

Title 35, US. Code § 112 (in part)

Specification

The specification shall contain a written description of the invention, and of the manner and process of
making and using it, in such full, clear, concise and exact terms also enable any person skilled in the art to which it
pertains, or with which it is mostly nearly connected, to make and use the same, and shall set forth the best mode
contemplated by the inventor of carrying out his invention.

Title 35, US. Code § 119

Benefit of earlier filing date in foreign country; right of priority

An application for patent for an invention filed in this country by any person who has, or whose legal
representatives or assigns have, previously regularly filed an application for a patent for the same invention in a
foreign country which affords similar privileges in the case of applications filed in the United States or to citizens of

the United States, shall have the same effect as the same application would have if filed in this country on the date
on which the application for patent for the same invention was first filed in such foreign country, if the application in
this country is filed within twelve months from the earliest date on which such foreign application was filed; but no
patent shall be granted on any application for patent for an invention which had‘been patented or described in a
printed publication in any country more than one year before the date of he actual filing of the application in this
country, or which had been in public use or on sale in this country more than one year prior to such filing.

Title 35, US. Code § 120

Benefit or earlier filing date in the United States

An application for patent for an invention disclosed in the manner provided by the first paragraph of section
112 of this title in an application previously filed in the United States, or as provided by section 363 of this title,
which is filed by an inventor or inventors named in the previously filed application shall have the same effect, as to

. such invention, as though filed on the date of the prior application, if filed before the patenting or abandonment of or
termination of proceedings on the first application or an application similarly entitled to the benefit of the filing date
of the first application and if it contains or is amended to contain a specific reference to the earlier filed application.

Please read carefully before signing the Declaration attached to the accompanying Application.

If you have any questions, please'contact Morgan & Finnegan, L.L.P.

FORM:COMB-DEC.NY
Rev. 5/21/98

' 492351_1
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This Page is Inserted by IFW Indexing and Scanning

Operations and is not part of the Official Record

BEST AVAILABLE IMAGES

Defective images within this document are accurate representations of the original
documents submitted by the applicant. '

Defects in the images include but are not limited to the items checked:

Cl BLACK BORDERS

Cl IMAGE CUT OFF AT TOP, BOTTOM OR SIDES

EQD TEXT OR DRAWING

El BLURRED OR ILLEGIBLE TEXT OR DRAWING ,

_ El SKEWED/SLANTED IMAGES

El COLOR OR BLACK AND WHITE PHOTOGRAPHS

Cl GRAY SCALE DOCUMENTS .

- ms OR MARKS ON ORIGINAL DOCUMENT
Cl REFERENCE(S) OR EXHIBIT(S) SUBMITTED ARE POOR QUALITY

EJ OTHER:

IMAGES ARE BEST AVAILABLE COPY.

As rescanning these documents will not correct-the image

problems checked, please do not report these problems to

the IFW Image Problem Mailbox;
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Docket No. 3125-4003USl

Serial No. Continuation of 10/016 517 

IN THE UNITEDSTATES PATENT AND TRADEMARK OFFICE

Applicant(s) McNally et al.

Group Art Unit: 2173 (parent case)

Serial No.: Continuation of 10/016,517

Examiner: Cao Nguyen (parent case)

Filed: HEREWITH

For: INFORMATION MANAGEMENT AND SYNCHRONOUS

COlVflVIUNICATIONS SYSTEM WITH MENU GENERATION, AND

HANDWRITING AND VOICE MODIFICATION OF ORDERS

PRELIMINARY AMENDMENT

Mail Stop
Commissioner for Patents

PO. Box 1450

Alexandria, VA 22313-1450

 

Sir:

Prior to examination, please amend the Application as follows.

No fees are believed due in connection with this Amendment. However, in the

event any fees are necessitated by this Amendment, the Commissioner is hereby authorized to

charge our deposit account no. 13-4500, order no. 3125-4003US 1.

Amendments to the Claims begin on page 2

Remarks begin on page 23

914310 vl
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Docket No. 3125-4003USI

Serial No. Continuation of 10/016 517 

Amendments to the Claims

The following listing of claims replaces all prior versions of the claims in the

Application. With this Amendment, claims 1-16 are cancelled without prejudice or disclaimer,

and claims 17-102 are added. No new matter has been added.

Listing of Claims

1-16 (Cancelled)

17. (New) An information management and synchronous communications system for generating

menus comprising:

a. a central processing unit,

b. a data storage device connected to said central

processing unit,

c. an operating system including a graphical user

interface,

(1. a first menu stored on said data storage device,

e. application software for generating a second menu

from said first menu,

wherein the application software facilitates the generation of the second menu by

allowing selection of items from the first menu, addition of items to the second menu and

assignment of parameters to items in the second menu using the graphical user interface of said

operating system and wherein data comprising the second menu is synchronized between the

2
914310 v1
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Docket No. 3125-4003USl

Serial No. Continuation of 10/016 517 

data storage device connected to the central processing unit and at least one other computing

device.

18. (New) An information management and synchronous communications system in accordance

with claim 17, wherein the second menu is a restaurant menu.

19. (New) An information management and synchronous communications system in accordance

with claim 17, wherein the second menu is capable ofbeing displayed on the display screen of a

wireless computing device.

20. (New) An information management and synchronous communications system in accordance

with claim 19, wherein selections from the second menu are capable of being transmitted to a

receiving computer by wireless link.

21. (New) An information management and synchronous communications system in accordance

with claim 17, wherein the second menu is capable of being displayed on display screens of

computers in a network.

22. (New) An information management and synchronous communications system in accordance

with claim 21, wherein the computer network is the internet.

23. (New) An information management and synchronous communications system in accordance

with claim 19, wherein selections fiom the second menu are capable of being transmitted to a

914310 vl
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Serial No. Continuation of 10/016 517 

receiving computer via the intemet.

24. (New) An information management and synchronous communications system in accordance

with claim 17, wherein the second menu is created in conformity with hypertext markup

language or extensible markup language.

25. (New) An information management and synchronous communications system in accordance

with Claim 17, wherein the second menu overwrites the first menu.

26. (New) The information management and synchronous communications system of claim 17,

wherein the first menu and the second menu are both capable of being displayed in the same

window on the display screen.

27. (New) The information management and synchronous communications system of claim 17,

wherein the items comprising the second menu are a subset of the items comprising the first

menu.

28. (New) An information management and synchronous communications system for generating

menus comprising:

a. a microprocessor,

b. a display device,

c. a data and instruction input device,

4
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d. a data storage device for storing information and

instructions entered through said data and

instruction input means or information generated by

said microprocessor,

e. an operating system,

f. a master menu stored on said data storage device for

generating a modified menu, and

g. application software,

wherein said microprocessor, operating system and application software are operative to

display the master menu on the display device in response to instructions programmed into said

microprocessor, operating system, application software and information and instructions entered

through said data input device, and wherein said microprocessor, operating system and

application software are operative to create the modified menu from said master menu in

response to information and instructions entered through said data and instruction input device

and wherein data comprising the modified menu is synchronized between the data storage device

and at least one other computing device.

29. (New) The information management and synchronous communications system of claim 28,

further comprising means for transferring the modified menu to a digital computing device.

30. (New) The information management and synchronous communications system of claim 29,

wherein the digital computing device is a wireless handheld device.

914310 vl
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31. (New) The information management and synchronous communications system of claim 28,

further comprising means for downloading the modified menu to the intemet or a Web page.

32. (New) The information management and synchronous communications system of claim 31,

further comprising means for converting the modified menu to hypertext markup language or

extensible markup language.

33. (New) The information management and synchronous communications system of claim 31,

wherein the items comprising the modified menu are a subset of the items comprising the master

menu.

34. (New) An information management and synchronous communications system in accordance

with claim 28, wherein said operating system includes a graphical user interface and wherein

said microprocessor, operating system and application sofiware are operative to generate the

modified menu by facilitating selection of items from said master menu using the graphical user

interface of said operating system.

35. (New) An information management and synchronous communications system in accordance

with claim 28, wherein said master menu is organized in a hierarchical tree structure having

branches comprising menu items and wherein the modified menu is at least partially generated

by selecting items from the branches of the tree structure.

36. (New) In a computer system having an input device, a storage device, a video display, an

914310 v1
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operating system including a graphical user interface and application software, an information

management and synchronous communications method comprising the steps of:

a. outputting at least one window on the video display;

b. outputting a first menu in a window on the video

display;

c. displaying a cursor on the video display;

(1. selecting items fiom the first menu with the input

device or the graphical user interface;

e. inserting the items selected from the first menu into

a second menu, the second menu being output in a

window;

f. optionally adding additional items not included in

the first menu to the second menu using the input

device or the graphical user interface;

g. ‘ storing the second menu on the storage device; and

h. synchronizing the data comprising the second menu

between the storage device and at least one other

data storage medium, wherein the other data storage

medium is connected to or is part of a different

computing device.

37. (New) The method of claim 36, further comprising the step of transferring data or

instructions representative of the second menu to a remote digital device or Web page.

914310 vl
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38. (New) The method of claim 37, wherein said data or instructions representative of the second

menu are transferred by a wireless link.

39. (New) The method of claim 36, wherein the selected items and optional additional items are

inserted into a second menu which is displayed in the same window as the first menu.

40. (New) The method of claim 37, comprising the further steps of selecting at least one item

from the second menu and transmitting at least one item selected to another computer.

41. (New) The method of claim 40, wherein at least one item selected from the second menu is

transmitted to another computer by wireless link or the internet.

42. (New) The method of claim 37, wherein the second menu is displayed on the remote digital

device or Web page in page format.

43. (New) The method of claim 36, wherein the second menu overwrites the first menu.

44. (New) The method of claim 36, wherein the items comprising the second menu are a subset

of the items comprising the first menu.

45. (New) An information management and synchronous communications system for use with

wireless handheld computing devices and hospitality computing systems comprising:

914310 vl

Apple, Exhibit 1008, Page 73



Apple, Exhibit 1008, Page 74

Docket No. 3125-4003USl

Serial No. Continuation of 10/016 517 

a. a central database containing hospitality

applications and data,

b. at least one wireless handheld computing device on

which hospitality applications and data are stored or

displayed,

c. an application program interface, and

d. a communications control module;

wherein applications or data are synchronized wirelessly between the central database

and at least one wireless handheld computing device and wherein the applications program

interface and communications control module establish a seamless link between the data in the

central database and the data on the wireless handheld computing device.

46. (New) The information management and synchronous communications system of claim 45

wherein the communications control module and the application program interface enable the

automatic generation of and updating of operator menus or screens on the handheld computer

based on data from the central hospitality database.

47. (New) The information management and synchronous communications system of claim 46

wherein messaging formats are used which are in conformity with HTML or XML messaging

formats.

48. (New) An information management and synchronous communications system for use with

914310y1
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wireless handheld computing devices and hospitality applications comprising:

a. a central database containing hospitality

applications and data,

b. at least one wireless computing device,

c. at least one wireless paging or beeper device,

(1. an applications program interface, and

e. a communications control module;

wherein hospitality applications or data are synchronized between the central database, at

least one wireless computing device and at least one wireless paging or beeper device and

wherein messaging to the wireless paging or beeper device is enabled directly from the operator

interface of the wireless computing device.

49. (New) An information management and synchronous communications system comprising:

a. a central database containing applications and data,

b. a first computing device associated with the central

database,

c. a second computing device associated with a second

storage medium containing applications and data,

(1. an applications program interface, and

e. a communications control module;

wherein applications or data are synchronized between the central database and the

second storage medium and wherein the applications program interface and communications

control module establish a seamless link between the data in the central database and the data on

10
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the second storage medium.

50. (New) The information management and synchronous communications system of claim 49

wherein the communications control module and the applications program interface enable the

automatic generation of and updating of operator menus or screens on the second computing

device based on data from the central database.

51. (New) The information management and synchronous communications system of claim 17

wherein the second menu is generated by manually selecting items from the first menu, adding

items to the second menu or assigning parameters to items in the second menu.

52. (New) The information management and synchronous communications system of claim 17

wherein the data is synchronized by digital transmission between the data storage device

connected to the central processing unit and at least one other computing device.

53. (New) The information management and synchronous communications system of claim 28

wherein the modified menu is generated by manually selecting items from the master menu.

54. (New) The information management and synchronous communications system of claim 28

wherein the data is synchronized by digital transmission between the data storage device and at

least one other computing device.

55. (New) The computer system of claim 36 wherein the data is synchronized by digital
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transmission between the storage device and at least one other data storage medium.

56. (New) The information management and synchronous communications system of claim 45

wherein the applications or data are synchronized by digital data transmission between the

central database and at least one wireless handheld computing device.

57. (New) The information management and synchronous communications system of claim 48

wherein the applications or data are synchronized by digital data transmission between the

central database, at least one wireless computing device and at least one wireless paging or

beeper device.

58. (New) The information management and synchronous communication system of claim 45,

48, or 49 wherein the synchronized data relates to orders.

59. (New) The information management and synchronous communication system of claim 45,

48, or 49 wherein the synchronized data relates to waitlists

60. (New) The information management and synchronous communication system of claim 45,

48, or 49 wherein the synchronized data relates to reservations.

61. (New) The information management and synchronous communication system of claim 45 or

48 wherein the synchronized data is sent from at least one of the wireless computing devices to a

receiver at a valet parking base station.

12
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62. (New) The information management and synchronous communication system of claim 45 or

48 wherein the synchronized data is sent from at least one of the wireless computing devices to a

wireless paging device.

63. (New) The information management and synchronous communication system of claim 49

wherein the synchronized data is sent from said second computing device to a receiver at a valet

parking base station.

64. (New) The information management and synchronous communication system of claim 49

wherein the synchronized data is sent from said second computing device to a wireless paging

device.

65. (New) The information management and synchronous communication system of claim 17

wherein said application software acts to facilitate generation of the second menu such that the

second menu is appropriate for a specified time of day. i

' 66. (New) The information management and synchronous communication system of claim 17

wherein said application software further facilitates the generation of multiple menus, each of

said multiple menus being appropriate for a particular time of day.

67. (New) The information management and synchronous communication system of claim 17

wherein the facilitation of second menu generation by said application software takes into

13
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account specified parameters, such that the second menu so generated includes items that satisfy

the specified parameters.

68. (New) The information management and synchronous communication system of claim 67

wherein the second menu so generated further includes manually selected items.

69. (New) The information management and synchronous communication system of claim 17

wherein the second menu is applicable to table-based customer ordering.

70. (New) The information management and synchronous communication system of claim 17

wherein the second menu is applicable to drive-through customer ordering.

71. (New) The information management and synchronous communication system of claim 17

wherein the second menu is applicable to customer ordering via intemet.

72. (New) The information management and synchronous communication system of claim 17

wherein the second menu is applicable to customer ordering via telephone.

73. (New) The information management and synchronous communication system of claim 17

wherein the second menu is applicable to customer ordering via wireless device.

74. (New) The information management and synchronous communication system of claim 67

wherein said specified parameters involve recipe content.

14
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75. (New) The information management and synchronous communication system of claim 28

wherein said microprocessor, operating system, and application sofiware are fiirther operative to

create said modified menu such that the modified menu is appropriate for a specified time of day.

76. (New) The information management and synchronous communication system of claim 28

wherein said microprocessor, operating system, and application software are further operative to

create multiple menus, each of said multiple menus being appropriate for a particular time of

day.

77. (New) The information management and synchronous communication system of claim 28

wherein the creation of said modified menu by said microprocessor, operating system, and

application software takes into account specified parameters, such that the modified menu so

created includes items that satisfy the specified parameters.

78. (New) The information management and synchronous communication system of claim 77

wherein the modified menu so generated firrther includes manually selected items.

79. (New) The information management and synchronous communication system of claim 28

wherein the modified menu is applicable to table-based customer ordering.

80. (New) The information management and synchronous communication system of claim 28

wherein the modified menu is applicable to drive-through customer ordering.

15
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81. (New) The information management and synchronous communication system of claim 28

wherein the modified menu is applicable to customer ordering via intemet.

82. (New) The information management and synchronous communication system of claim 28

wherein the modified menu is applicable to customer ordering via telephone.

83. (New) The information management and synchronous communication system of claim 28

wherein the modified menu is applicable to customer ordering via wireless device.

84. (New) The information management and synchronous communication system of claim 77

wherein said specified parameters involve recipe content.

85. (New) The method of claim 36 wherein said application sofiware acts to facilitate generation

of the second menu such that the second menu is appropriate for a specified time of day.

86. (New) The method of claim 36 wherein said application sofiware facilitates the generation

of multiple menus, each of said multiple menus being appropriate for a particular time of day.

87. (New) The method of claim 36 wherein said application software acts to facilitate generation

of the second menu, the taking into account specified parameters such that the second menu so

generated includes items that satisfy the specified parameters.

16
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88. (New) The method of claim 87 wherein the second menu so generated further includes

manually selected items.

89. (New) The method of claim 36 wherein the second menu is applicable to table—based

customer ordering.

90. (New) The method of claim 36 wherein the second menu is applicable to drive-through

customer ordering.

91. (New) The method of claim 36 wherein the second menu is applicable to customer ordering

via intemet.

92. (New) The method of claim 36 wherein the second menu is applicable to customer ordering

via telephone.

93. (New) The method of claim 36 wherein the second menu is applicable to customer ordering

via wireless device.

94. (New) The information management and synchronous communication system of claim 61

wherein a non-simultaneous protocol is used to acknowledge receipt of the data at the valet

parking base station.

95. (New) An information management and synchronous communications system for use with

17
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wireless handheld computing devices and computing systems comprising:

a.

d.

a central database containing gaming or casino

applications and data,

at least one wireless handheld computing device on

which gaming or casino applications and data are

stored or displayed,

an application program interface, and

a communications control module;

wherein gaming or casino applications or data are synchronized wirelessly between the

central database and at least one wireless handheld computing device and wherein the

applications program interface and communications control module establish a seamless link

between the data in the central database and the data on the wireless handheld computing device.

96. (New) An infonnation management and synchronous communications system comprising:

914310vl

a.
a central database containing gaming or casino

applications and data,

a first computing device associated with the central

database,

a second computing device associated with a second

storage medium containing gaming or casino

applications and data,

an applications program interface, and

a communications control module;
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wherein applications or data are synchronized between the central database and the

second storage medium and wherein the applications program interface and communications

control module establish a seamless link between the data in the central database and the data on

the second storage medium.

97. (New) An information management and synchronous communications system for use with

cell phones and computing systems comprising:

a. a central database containing hair salon applications

and data,

b. at least one cell phone on which hair salon

applications and data are stored or displayed,

c. an application program interface, and

d. a communications control module;

wherein hair salon applications or data are synchronized wirelessly between the central

database and at least one cell phone and wherein the applications program interface and

communications control module establish a seamless link between the data in the central

database and the data on the cell phone.

98. (New) The information management and synchronous communications system of claim 97,

wherein reservations data is synchronized.

99. (New) The information management and synchronous communications system of claim 97,.

wherein waitlist data is synchronized.

19
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100. (New) An information management and synchronous communications system comprising:

a. a central database containing gaming or casino

applications and data,

b. a first computing device associated with the central

database,

c. a second computing device associated with a second

storage medium containing gaming or casino

applications and data,

d. at least one web server,

e. an applications program interface, and

f. a communications control module;

wherein applications or data are synchronized between the central database, the second storage

medium, and the web server and wherein the applications program interface and communications

control module establish a seamless link between the data in the central database, the data on the

second storage medium, and data on the web server.

101. (New) An information management and synchronous communications system for use with

wireless handheld computing devices, the internet, and computing systems comprising:

a. a central database containing hair salon applications

and data,
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b. at least one wireless handheld computing device on

which hair salon applications and data are stored or

displayed,

c. at least one web server,

d. an application program interface, and

e. a communications control module;

wherein hair salon applications or data are synchronized wirelessly between the central database,

the web server, and at least one Wireless handheld computing device and wherein the »

applications program interface and communications control module establish a seamless link

between the data in the central database, the data on the wireless handheld computing device,

and data on the web server.

102. (New) An information management and synchronous communications system for use with

wireless handheld computing devices and computing systems comprising:

a. a central database containing hair salon applications

and data,

b. at least one wireless handheld computing device on

which hair salon applications and data are stored or

displayed,

c. an application program interface, and

d. a communications control module;

wherein hair salon applications or data are synchronized wirelessly between the central database

and at least one wireless handheld computing device and wherein the applications program
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interface and communications control module establish a seamless link between the data in the

central database and the data on the wireless handheld computing device.

22
914310 vl

Apple, Exhibit 1008, Page 87



Apple, Exhibit 1008, Page 88

Docket No. 3125-4003USl

Serial No. Continuation of 10/016 517 

REMARKS

1. Status of the Claims

With this Amendment, claims 1-16 are cancelled without prejudice or disclaimer

and claims 17-102 are added. Claims identical to claims 17—94 were previously pending in US.

Patent Application Serial No. 10/015,729, filed November 1, 2001.

Claims identical to claims 17-35, 36-44, and 51—55 were previously rejected under

35 U.S.C. 102(e) as being anticipated by Cupps et al. (US. Patent No. 5,991,739).

Claims identical to claims 45-50 and 56-57 were previously rejected under 35

U.S.C. 103(a) as being unpatentable over Cupps in view of Behr (US. Patent No. 6,107,944).

Of the pending claims for which identical claims were previously rejected, claims

17, 28, 36, 45, 48, and 49 are independent.

11. Rejections Under 35 U.S.C. 1021c)

Claims identical to independent claims 17, 28, and 36 were previously rejected

under 35 U.S.C. 102(e) as being anticipated by Cupps et a1.

With regard to claims identical to independent claims 17, 28, and 36 of the

present application, the Examiner argues that at lines 35-65 of column 9 and in figs. 2 and 3a—3f,

Cupps discloses information synchronization involving a second or modified menu. However

Applicants respectfully disagree.

The first section cited by the examiner, column 9 lines 35-65, fails to disclose

information synchronization involving a second or modified menu, nor any other sort of

information synchronization. This section instead discloses a customer providing to an online

ordering machine registration information, location information, time of day information, and an
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indication of the type of service sought (e.g., takeout or delivery).

The second section cited by the examiner, Fig. 2, is a system overview showing

an online ordering machine component, a client machine component connected to the online

ordering machine via a network, and telephone and fax components connected to the online

ordering machine via standard telephone lines. Also shown are various elements of the online

ordering machine and the client machine. However, nowhere in the figure or its corresponding

disclosure is there any indication of synchronization involving a second or modified menu.

More generally, there is no disclosure of information synchronization occurring between any

components of the system, nor is there disclosure of any other sort of information

synchronization.

The third Section cited by the examiner, Figs. 3a-3f, fails to disclose

synchronization involving a second or modified menu and instead discloses the “schema” — that

is the organization and structure — of the order database 128 (see Cupps, Col. 5 Ln. 21). Nowhere

in the figures or in the corresponding disclosure is there even any indication that the order

database is involved in any sort of information synchronization. In fact, there is no disclosure of

any sort of information synchronization in this section.

Furthermore, the remainder of the Cupps disclosure also fails to disclose

synchronization involving a second or modified menu, nor any other sort of information

synchronization.

Accordingly, Cupps fails to disclose at least the aspect of independent claim 17

wherein:

"... data comprising the second menu is smchronized

between the data storage device connected to the central

processing unit and at least one other computing device ..."

(emphasis added).
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Similarly, Cupps also fails to disclose at least the aspect of independent claim 28

“ data comprising the modified menu is synchronized

between the data storage device and at least one other

computing device...”

(emphasis added).

Furthermore, Cupps fails to disclose at least the aspect of independent claim 36

“ smchronizing the data comprising the second menu

between the storage device and at least one other data

storage medium, wherein the other data storage medium is

connected to or is part of a different computing device...”

(emphasis added).

The disclosure'of the present invention explains that according to the claimed

synchronization there is, for example:

“ fast smchronization between a central database and

multiple handheld devices, synchronization and

communication between a Web server and multiple handheld

devices, a well-defined API that enables third parties such as

POS companies, affinity program companies and internet

content providers to fully integrate with computerized

hospitality applications, real-time communication over the

intemet with direct connections or regular modem dialup

connections and support for batch processing that can be

done periodically throughout the day to keep multiple sites in

sypch with the central database”

(see disclosure, p. 9 In. 21 —p. 10 In. 4; emphasis added).

As another example, the disclosure of the present invention notes that according

to such synchronization:

914310 v1

“ a reservation made online can be automatically

communicated to the backoffice server and then

smchronized with all the wireless handheld devices

wirelessly. Similarly, changes made on any of the wireless

handheld devices are reflected instantaneously on the

backoffice server Web pages and the other handheld

25

Apple, Exhibit 1008, Page 90



Apple, Exhibit 1008, Page 91

Docket No. 3125-4003US1

Serial No. Continuation of 10/016 517 

devices”

(see disclosure, p. 10 In. 15-19; emphasis added).

In light of the above, Applicants submit that independent claims 17, 28, and 36

are in condition for allowance. Those claims that depend therefrom, for at least the above-

identified reasons, are also thought to be allowable.

III. Rejections Under 35 U.S.C. 1031a)

Claims identical to independent claims 45, 48, and 49 were previously rejected

under 35 U.S.C. 103(a) as being unpatentable over Cupps in view of Behr.

As explained above, Cupps fails to disclose any sort of information

synchronization. Furthermore, Applicants find no disclosure in Behr of any sort of information

synchronization, nor does the Examiner provide any reference to such disclosure in Behr.

Applicants therefore submit that Cups and Behr, alone or in combination, fail to

disclose, teach, or suggest at least the aspect of independent claim 45 wherein:

"... applications or data are smchronized wirelessly between
the central database and at least one wireless handheld

computing device and wherein the applications program

interface and communications control module establish a
seamless link between the data in the central database and

the data on the wireless handheld computing device."

(emphasis added).

Similarly, Cups and Behr, alone or in combination, fail to disclose, teach, or

suggest at least the aspect of independent claim 48 wherein:

“ hospitality applications or data are sypchronized

between the central database, at least one wireless computing

device and at least one wireless paging or beeper device and

wherein messaging to the wireless paging or beeper device is

enabled directly from the operator interface of the wireless

computing device”

(emphasis added).
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Furthermore, Cups and Behr, alone or in combination, fail to disclose, teach, or

suggest at least the aspect of independent claim 49 wherein:

“

.. applications or data are synchronized between the

central database and the second storage medium and wherein

the applications program interface and communications
control module establish a seamless link between the data in

the central database and the data on the second storage
medium.”

(emphasis added).

The Examiner also states:

“Behr teaches wireless handheld computing device on which

hospitality application (see col. 14, lines 1-57)”.

Applicants respectfully disagree. Behr discloses “a method of providing route

guidance information and other information from a base unit to a mobile unit in response to a

request from the mobile unit” (see Behr, Col. 4 Ln. 28-31). Behr explains that the mobile unit

sends the request for route guidance as a “query message 120” including a “destination field

144” and a “destination type field 146”, and, for example , that the “destination type field 146

may be ‘restaurant’, and the destination field 144 may be ‘McDonald’s’” (see Behr, Col. 14 Ln.

37-44). Behr also discloses that other specifiable destinations include “airport[s]” and

“museum[s]” (see Behr, Col. 14 Ln. 42).

However, Applicants submit that simply stating that a mobile unit may request

from a navigation system directions to a restaurant does not constitute disclosure of a hospitality

software application. As known in the art, a hospitality software application is, for example, a

piece of software used to provide operational solutions in hospitality industries such as

restaurants and hotels concerning, for example, food ordering, menus, wait-lists and reservations.

Accordingly, Applicants submit that Behr fails to teach a “wireless handheld computing device

on which hospitality application” as suggested by the Examiner.
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In light of at least the above, Applicants submit that independent claims 45, 48,

and 49 are in condition for allowance. Those claims that depend therefrom, for at least the above-

identified reasons, are also thought to be allowable.

IV. New Claims 95-102

With this amendment, new claims 95-102 are added. No new matter has been

added.

Applicants respectfiJlly submit that these claims are allowable over the cited art

and in condition for allowance.

V. Conclusion

No new matter is added by this Amendment. Entry hereof is respectfully

requested prior to examination on the merits.

Applicants respectfully submit that this Application is in condition for allowance

for which action is earnestly solicited.

If a telephone conference would facilitate prosecution of this Application in any

way, the Examiner is invited to contact the undersigned at the number provided.

VI. Authorization

The Commissioner is hereby authorized to charge any fees which may be required

for this amendment, or credit any overpayment to Deposit Account No. 13-4500, Order No.

3125-4003USl. A DUPLICATE OF THIS DOCUMENT IS ATTACHED.

Furthermore, in the event that an extension of time is required, the Commissioner

is requested to grant a petition for that extension of time which is required to make this response
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In light of at least the above, Applicants submit that independent claims 45, 48,

and 49 are in condition for allowance. Those claims that depend therefrom, for at least the above-

identified reasons, are also thought to be allowable.

IV. New Claims 95-102

With this amendment, new claims 95-102 are added. No new matter has been

added.

Applicants respectfully submit that these claims are allowable over the cited art

and in condition for allowance.

V. Conclusion

No new matter is added by this Amendment. Entry hereof is respectfully

requested prior to examination on the merits.

Applicants respectfully submit that this Application is in condition for allowance

for which action is earnestly solicited.

If a telephone conference would facilitate prosecution of this Application in any

way, the Examiner is invited to contact the undersigned at the number provided.

VI. Authorization

The Commissioner is hereby authorized to charge any fees which may be required

for this amendment, or credit any overpayment to Deposit Account No. 13-4500, Order No.

3125-4003US1. A DUPLICATE OF THIS DOCUMENT IS ATTACHED.

Furthermore, in the event that an extension of time is required, the Commissioner

is requested to grant a petition for that extension of time which is required to make this response

. 28
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timely and is hereby authorized to charge any fee for such an extension of time or credit any

overpayment for an extension of time to the above-noted Deposit Account and Order No.

Respectfully submitted,

MORGAN & FINNEGAN, L.L.P.

Dated: April 22, 2005

 
Mailing Address:

MORGAN & FINNEGAN, L.L.P. Registration 0. 51,133
3 World Financial Center

New York, New York 10281-2101

(212) 415-8746

(212) 415-8701 (Fax)
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